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1 Overview 
The Moving Pixel Company DPhy Decoder HS is an instrument designed to monitor and 
decode traffic on up to 4 MIPI DPhy lanes running up to 2.5 Gbps.  The instrument 
operates as stand-alone acquisition hardware for DPhy bus activity, and is used in 
conjunction with controlling software that also provides DSI, CSI-2, and DPhy protocol 
decode of acquired data. 
 
The main functions of the DPhy Decoder HS hardware are to: 
 
 Input and convert serial HS packet data to bytes 
 Input and convert encoded LPDT and escape mode data to bytes 
 Process DPhy data and package into records 
 Provide DPhy, DSI, and CSI-2 protocol and state triggering for acquisition 
 Store records into memory for acquisition 
 Provide link activity indicators, status, and statistics including ECC error, CRC 

error, and HS burst error events. 
 
The DPhy Decoder is controlled from a Windows application called DPhyDecoderHSCtl, 
which communicates with the Decoder via a USB connection.  Using this application, the 
user can monitor DPhy bus activity, select modes of operation, configure the triggering 
and functions of the instrument, and initiate the acquisition and capture of DPhy traffic.   
 
In addition, DPhyDecoderHSCtl provides post-processing and protocol disassembly of 
acquired data.  For those familiar with Tektronix bus support packages that run on the 
instrument, the disassembly window of DPhyDecoderHSCtl has a similar look-and-feel.  
However, extensive improvements have been made to the basic listing functionality, 
providing sophisticated functions for displaying, filtering, and searching captured data.  
This includes a packet type summary listing of all packet types in the acquired trace.  It 
also includes a video frame summary listing that provides statistics, navigation, viewing, 
and saving of video frames to files.  Decoding, viewing, and saving compressed DSC 1.2 
video frames is also supported. 
 
The DPhy Decoder HS is a successor instrument to the DPhy Decoder and has several 
improvements over its predecessor: 
 
DPhy Decoder HS DPhy Decoder 
Supports up to four lanes @ 2.5 Gbps Supports up to four lanes @ 1.5 Gbps 
Supports DPhy, DSI, CSI-2 version 1.2 Supports DPhy, DSI, CSI-2 version 1.1 
Intended to be upgradable for DSI 2.0 Not upgradable 
1 GB acquisition memory 512 MB acquisition memory 
Efficient, lane-independent data storage 
(50% effective data packing) 

Per-lane data storage (33% effective data 
packing at 4 lanes with timestamps) 

Supports “Monitor Mode” operation using 
solder-down probes 

Supports “Monitor Mode” operation using 
solder-down probes 
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Supports new “Receive Mode” operation 
using SMA inputs (includes termination 
control and simple configurable BTA 
response packet) 

No support for “Receive Mode” operation 

1.1 MIPI Standards Supported 
The DPhy Decoder HS and DPhyDecoderHSCtl were originally designed to support the 
following MIPI standards up to 2.5 Gbps: 

 CSI2 1.3 
 DSI 1.3.1 
 DPhy 1.2 
 DSC 1.2 

 
However, protocol extensions for DSI2 1.0, CSI2 2.0 and DPhy 2.1 have been made, 
including the following features: 

 DSI packet scrambling (DSI2 1.0) 
 CSI per-lane scrambling (CSI2 2.0) 
 Alternate Calibration Sequence (DPhy 2.1) 
 Preamble Sequence (DPhy 2.1) 
 VCX extension field (CSI2 2.0) 
 Raw 16 and Raw20 video modes (CSI2 2.0) 

 
Notable features that are NOT currently supported in the instrument are: 

 xN sublink support 
 HS-Idle and LRTE (latency reduced transport efficiency) 

 
,  
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2 Setup & Installation 
System requirements for the DPhyDecoderHSCtl application are as follows: 

 Installation must be on a Windows PC running XP, Win7, Win8, or Win10 

 Both 32-bit and 64-bit processors are supported but only 64-bit processors can 
take advantage of the full 1 GB memory in the DPhy Generator.  Host computers 
with 32-bit processors or with limited memory (< 4 GB) will be restricted to 
approximately 256 MB of acquisition memory in the DPhy Decoder HS. 

 A USB2 or USB3 port is required to communicate with the DPhy Generator 
instrument.  Using a USB3 port is highly recommended for program download 
speed. 

 
To install DPhyDecoderHSCtl, simply execute the installation file 
“DPhyDecoderHSCtlNstall.exe” on the installation CD and step through the setup 
windows.  As part of the installation, a USB driver is installed called CyUSB3.sys.  This 
driver is required for the software to recognize the DPhy Decoder HS instrument when 
connected to USB. 
 
Periodically, new versions of DPhyDecoderHSCtl are available on the Moving Pixel 
Company web-site at the following link:    
 

http://www.movingpixel.com/main.pl?MIPI_.html 
 
Simply download, unzip and run the DPhyDecoderHSCtlNstall.exe program.  Note that 
the previous version is automatically uninstalled when installing a newer version of 
DPhyDecoderHSCtl. 
 
The DPhyDecoderHSCtl application is installed by default in: 
 

c:\Program Files\TMPC\DPhyDecoderHSCtl    (32-bit computers) 
c:\Program Files (x86)\TMPC\DPhyDecoderHSCtl    (64-bit computers) 

 
The following shortcuts are provided in the Start Menu, under DPhyDecoderHSCtl 

 DPhyDecoderHSCtl.exe: a link to the application executable 

 DPhyDecoderHSCtlUsersManual_x_x.pdf:  link to this manual 

 DPhyDecoderHSCtlRPC_x_x.pdf: RPC manual for instrument remote control 

 TestDPhyDecoderHSCtlRPC: sample Visual Studio project demonstrating 
remote control 

 Uninstall.bat: a link for uninstalling the application 

 
Once the application is installed, set up connections to your DPhy Decoder HS 
instrument and start up as follows: 
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 Connect a USB2 or USB3 cable between the host computer and instrument 
 Connect your DUT to either the SMA inputs (Receive Mode) or high-impedance, 

solder in inputs (Monitor Mode). 
 Plug in and connect the 24V power adaptor 
 Power on the instrument 
 Launch DPhyDecoderHSCtl application. 
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3 DPhy Decoder HS Concepts 

3.1 Data Records 
The main function of the DPhy Decoder HS hardware is to monitor up to four lanes of 
DPhy bus traffic and package data into records for acquisition and display.  All facets of 
bus communication are captured from lane LP signaling to escape mode sequences to 
LPDT and HS burst packets.   
 
Depending on the current DPhy bus state, one of two types of data records are internally 
generated and stored.  The exact details are not important to the user in normal use, but a 
quick overview may be helpful to understanding other operational concepts. 
 
Basically, if one or more lanes are transmitting data in an HS burst, then HS data records 
containing packed and acquired lane data are generated.  Otherwise, LP data records are 
generated, containing the LP state of all lanes and a timestamp.  Both record types have 
associated status that conveys auxiliary state information about the record including 
various header flags, trigger information, etc. 
 
In general, LP data records are output only when one or more lanes change LP state.  
This significantly compresses the record set captured by the instrument and compacts the 
disassembly view.  As timestamps can indicate duration in a particular LP state, 
duplicated records is not necessary. 
 
There is one reason to duplicate records, however.  In particular, when bus activity is 
nearly idle then it is possible for the processing pipeline to stall and acquisition memory 
never to fill completely.  To handle this case, a control is provided (“Idle Timeout”) to 
specify an idle timeout period that forces duplicate LP records into the processing 
pipeline.  

3.2 Escape Mode 
A mode commonly enabled in the application is called “Escape Mode”.  This mode 
translates and replaces LP records that convey escape packets with higher-level protocol 
records for triggering and display.  If not enabled, escape-packet triggering and decoding 
(including LPDT packets) is not supported.  On the other hand, disabling “Escape Mode” 
does allow low-level LP edge transitions and timing to be seen if necessary for low-level 
debugging. 

3.3 Receive Mode 
Another mode option is called “Receive Mode”.1  When enabled, the instrument uses the 
SMA input connectors as lane inputs, which are actively terminated according to the 
DPhy protocol during HS bursts.  In addition, the user can specify a short response packet 
and return BTA (or other LP signaling response) to be transmitted when the DUT sends a 

                                                 
1 Receive Mode and Escape Mode are not exclusive and can be independently enabled/disabled.  
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BTA.  When “Receive Mode” is not enabled, the instrument operates in “Monitor Mode” 
(also referred to as “Sniff Mode”) using the instrument’s solder-down probe high-
impedance inputs.  In this mode, no lane terminations or BTA response packet support 
are provided. 

3.4 Triggering 
Triggering is the process of completing acquisition based on trigger criteria specified by 
the user.  Once the specified criteria are met, the instrument fills up memory with data 
records.  Note that even after acquisition has started, trigger criteria continues to be 
evaluated and the result is associated with data records for subsequent search and display.  
Thus, while there is only one trigger record (i.e. one record that triggered acquisition) 
there is no restriction on the number of records that may have their trigger flag set. 
 
The term “Prefill” is used to describe records in an acquisition preceding the trigger 
record.  Often, users want to see bus activity leading up to the trigger condition as much 
as activity that follows it.  A user control for prefill is available allowing 5% to 95% of 
the acquisition to precede the trigger record. 
 
In general, the prefill requirement must be met before a record satisfying the trigger 
criteria is considered.  This means that one or more records with their trigger bit set may 
not trigger acquisition.  In some cases this is not desirable as the trigger condition only 
occurs once in a test. To allow successful acquisition in this case, an option is provided 
(“Allow Trigger Before Prefill”) that ignores the prefill requirement for triggering if 
necessary. 
 
In the DPhy Decoder HS, various trigger modes are supported.  Simple modes such as 
triggering “Immediately” or on an error condition such as CRC error, ECC error or burst 
don’t require any further configuration.  Other modes require the user to define predicate 
terms that are then used in an arbitrary Boolean trigger equation.  Often this equation is 
simply an ANDing or ORing of predicate terms.   
 
A common form of triggering is based on packet data, where predicate terms are built 
from comparing masked fields in DSI/CSI packets and compared to constants.  Other 
trigger modes use LP Signal State, lane-zero LP Sequence State (e.g. BTA), or the lane-
zero Escape command to build their predicates. 
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4 Using DPhyDecoderHSCtl 

4.1 Connecting to the Instrument 
When the application is started, a connection dialog (see Figure 1) is shown for the user 
to select a DPhy Decoder instrument powered-on and reachable via USB.  This dialog 
can also be brought up for the user to switch instruments using the option in the Control 
menu labeled “Connect to DPhy Decoder...”. 
 

 

Figure 1 – Connection Dialog 
A drop-down control is provided with reachable instrument serial numbers as well as an 
option called “Offline”.  Offline mode allows using the application to be used without a 
connection to real hardware, useful for demonstration of the GUI, testing remote-control 
applications, and viewing saved disassembly traces.  Clicking the “Scan” button updates 
the instrument serial number control, adding any new instruments that have recently been 
powered on. 
 
Note that while multiple copies of the application can run at the same time, only one 
instance can be connected to a given instrument at a time.  Serial numbers of instruments 
that are in-use by another copy of the application are marked “(in use)”. 
 
To connect to an instrument, simple select the appropriate serial number and click OK.  
Note that the serial number and firmware version of the currently connected instrument 
appears in the status bar at the bottom-right of the main window.   
 
Shutting down the application will automatically disconnect from the instrument.  The 
user can explicitly disconnect using the “Disconnect from DPhy Decoder” menu option 
in the Control menu, leaving the application offline. 

4.2 Main Window 
Once connected, the main window is shown (see Figure 2).  The instrument serial number 
is shown in a bottom right pane on the status bar.  The main window contains all the user-
controls for configuring and operating the instrument.   
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Figure 2 – DPhyDecoderHSCtl Main Window 
The main window is divided into four areas of controls: configuration, status, trigger 
control, and receive control (the last two share a tabbed page).  The following sections 
describe each of these areas. 

4.2.1 Configuration Controls 
The section of the main window provides controls that support overall mode 
configuration and are located in the upper-left section of the main window.  They are: 
 
MIPI Standard – drop-down control to select the DSI or CSI standard.  This selection 
should be made first as it naturally resets the filtering and triggering options available to 
the user. 
 
Max Lane Count – drop-down control to select the maximum number of lanes to 
monitor for activity.  Unused lanes are forced to LP11 for the purposes of instrument 
monitoring and acquisition.  The instrument monitors DPhy bus activity on lane counts 
up to the Max Lane Count setting.  For example, with a Max Lane Count setting of 3, HS 
bursts using 1, 2, or 3 lanes will be detected automatically and the actual number of lanes 
participating in ongoing HS bursts is displayed in the status region.   



The Moving Pixel Company DPhyDecoderHSCtl User’s Manual. – Rev. 1.7 -- 6/12/18 

- Page 9 - 

 
Idle Timeout – drop-down control to set the idle time-out duration.  This setting is the 
maximum time to wait without outputting a record before inserting a duplicate LP record 
into the processing pipeline.  If timeout is set to “None”, the instrument will wait 
indefinitely for a change in input state, stalling the processing pipeline and possibly 
preventing detection of last active records in a trace. 
 
HS Resp Support – drop-down control to set the acquisition rate and phase for HS 
response capture.  For synchronous HS response capture at the same clock rate as the 
master, select “Full rate”.  For asynchronous HS response capture at ¼ clock rate, select 
either “¼ rate ph0” or “¼ rate ph1”.  At least one phase should acquire traffic without 
errors.  If DUT HS response traffic has errors, the user should try the other phase. 
 
Escape Mode – check box to enable escape-mode protocol detection and escape packet 
reconstruction, necessary for triggering and presentation of escape packets (including 
LPDT packets).  Note that if escape-mode is not enabled, triggering on escape packets is 
not supported and only low-level LP state transitions are displayed for escape packets in 
the disassembly listing.  
 
Receive Mode – check box to enable receive-mode operation.  If checked, the instrument 
connects to the SMA inputs as a true receiver, enabling/disabling lane terminations 
during HS bursts according to the DPhy protocol.  In addition, in this mode, the user can 
configure a single short LPDT response packet and/or other LP signaling to transmit on 
lane 0 whenever a BTA is seen on the bus.  If not checked, the instrument operates in 
monitor-mode (also called sniff-mode) using the high-impedance solder-in probe inputs. 
 
Disable HS Sync Detect – check-box to disable HS sync detection during input 
processing, triggering, and disassembly.  Generally, this is used only for low-level 
debugging and phy-level testing with non-protocol data traffic on the DPhy bus.  
Checking this option disables protocol-level testing and thus the flagging of protocol 
errors (and protocol statistics). 
 
Trig Out On Capture Only – check-box to set the output mode of the “Trig Out” signal 
of the instrument.  If checked, the “Trig Out” signal pulses high only for the trigger 
condition that causes acquisition.  If unchecked, the “Trig Out” signal pulses high 
whenever trigger conditions are met in the stream, whether or not the trigger causes 
acquisition.  Note that the “Trig Out” pulse duration is about 160 ns and retriggers within 
that time lengthen the pulse accordingly. 
 
Enable DSI2 Scrambling – check-box to indicate DSI traffic is scrambled according to 
the DSI2 specification (optional).  When checked, packet payloads are descrambled 
before processing.  If the instrument is running at least firmware version 2.1, real-time 
descrambling is supported, which means that CRC error detection and triggering are 
available.  Otherwise, only software descrambling is supported during disassembly.  
Accordingly, CRC Error statistics are disabled and triggering on CRC Error or Any Error 
is not available.   
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Enable CSI2 Scrambling – check-box to indicate CSI traffic is scrambled according to 
the CSI2 2.0 specification (optional).  When checked, HS burst data is descrambled (per-
lane) before processing.  If the instrument is running at least firmware version 2.1, real-
time descrambling is supported, which means that ECC/CRC error detection and 
triggering are available.  Otherwise, only software descrambling is supported during 
disassembly.  Accordingly, ECC/CRC Error statistics are disabled and triggering on 
ECC/CRC Error or Any Error is not available.   
 
Lane Map – drop-down control to configure a logical-to-physical mapping of data lanes 
connected to the instrument.  Each digit in the four-digit value selected represents a 
logical lane assignment.  Each position in the four-digit value represents a physical lane 
connector (starting with lane 3 down to lane 0).  Thus, the default setting of “3210” 
represents a unity mapping of logical lane to physical lane connector.  Setting the map 
value to “0123”, on the other hand, will decode the lane 3 connector as lane 0, lane 2 
connector as lane 1, etc.   
 
Note that there are some restrictive caveats associated with using a non-standard lane 
mapping.  In particular, physical lane 0 must participate in HS bursts for such traffic to be 
decoded properly.  For example, if physical lane 0 is used as logical lane 2, then only 3-
lane and 4-lane HS bursts will be decoded properly.  If used as logical lane 3, then only 
4-lane HS bursts will be decoded properly. 
 
Another caveat is in Receive Mode, where read response traffic is always output on 
physical lane 0 regardless of lane mapping.  Thus, effectively, Receive Mode responses 
are only useful if logical lane 0 is mapped to physical lane 0 in the lane mapping.     
 
Auto HS Freq – check box to enable the instrument to automatically detect the clock 
lane frequency.  When checked, the HS Clk Rate text box is disabled and automatically 
filled in with the detected clock lane bit rate. 
 
This mode is very useful and should work correctly for legal DPhy traffic.  However, 
there may be situations where non-conforming traffic patterns cause incorrect or erratic 
clock frequency detection.  In these cases, the user should disable “Auto HS Freq” and 
manually enter the HS Clk Rate. 
 
When this mode is enabled and the detected bit rate changes more than +/- 10%, this 
causes software to automatically resynchronize the hardware using the new bit rate.  In 
this case, there may be a brief period when errors are detected before the frequency and 
sampling phase change is completed.  Thus, as a convenience, all statistics are reset when 
a significant clock change is detected.   
 
HS Clk Rate – text box to indicate the detected clock lane bit rate during HS bursts.  
This value is used to set the sampling phase of the data relative to the clock on input.  Its 
accuracy becomes more important with increasing frequency, given the smaller valid 
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sampling windows.  Generally, if possible, it is best to use auto-detection (via Auto HS 
Freq) to set this value.  
 
HS Clk Adjust – up/down control to adjust fine delay timing on the incoming HS Clk for 
high-frequency acquisitions.  This timing control adjusts the clock relative to the ideal 
quadrature setting for acquisition and, normally, this value should thus be set to zero.  
However, modest adjustments are sometimes required depending on less-than-ideal 
acquisition conditions depending on input signal integrity, non-standard voltages, 
cabling, noise, or timing skew on the bus. 
 
Cal – button to automate finding an optimal HS Clk Adjust setting by sweeping a delay 
range.  This procedure requires valid HS traffic to be continually streaming on the bus as 
the valid clock window is validated using the detected ECC and CRC error count.  To 
use, simply click this button to initiate a sweep search within approximately +/- one bit 
period around the ideal quadrature setting small increments, measuring the number of 
ECC and CRC errors received in a short time period.  The sweep takes a few seconds and 
when complete, the optimum HS Clk adjustment setting is displayed and assigned to the 
control. 
 

Show Disasm – button to bring up the disassembly window for acquisition. 

 
Send – button to send the current configuration (including trigger settings) to hardware 
and reset the status display.  In particular, this is required operation to update changes 
made in the trigger configuration controls, but otherwise is not necessary for most other 
configuration controls (as these controls send new values automatically to hardware when 
changed).  The user is notified that the Send button should be clicked by the appearance 
of the text “Modified” to the lower-right of the Send button.  
 
Note: as this process also resets the instrument input logic, this button should also be used 
if the hardware gets into a bad state.  One possiblity in DSI is if the instrument might see 
traffic that causes it to incorrectly believe the DPhy bus owner is the device and not the 
host.  Resetting the hardware restores the bus owner flag in the instrument to “Host”. 

4.2.2 Trigger Tab Page Controls 
The trigger tab page is one of two tab pages occupying the right side of the main window.  
To show the page, click on the Trigger tab at the top.  
 
As mentioned in section 3.4, the DPhy Decoder has several triggering modes.  The 
triggering mode is selected via the Trigger Type drop-down control at the bottom-right 
corner of the Trigger Controls section.  The trigger mode should be selected first before 
other fields as the control options change based on mode.  The trigger modes available 
are:   

 Packet Fields – This is a common form of triggering.  In this trigger mode, the 
user defines predicate terms based on packet fields and a trigger equation to 
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evaluate and combine terms to determine the final trigger condition.  Predicate 
terms perform Boolean comparisons between packet fields and constant values. 

 LP Signal State – Compares LP signal state for any or all lanes (including the 
clock lane) as predicates evaluated in a Boolean equation to determine trigger 
state. 

 LP Sequence State – Evaluates the lane zero sequence state (e.g. BTA) as 
predicates evaluated in a Boolean equation to determine trigger state. 

 Escape Command – Compares escape command bytes as predicates evaluated in 
a Boolean equation to determine trigger state. 

 Skew Calibration – Sets the trigger flag on a skew calibration or alternate 
calibration burst. 

 CRC Error – Sets the trigger flag on a packet CRC error. 

 ECC Error – Sets the trigger flag on a packet ECC error. 

 Burst Error – Sets the trigger flag on an HS burst error, which occurs when valid 
HS Sync bytes for all active lanes in an HS burst cannot be synchronously 
detected.   

 Any Error – Sets the trigger flag on any error (CRC error, ECC error, or burst 
error). 

 Immediately – This mode causes immediate triggering once the Run button is 
clicked. 

 GPInput0 – Sets the trigger flag on a rising edge input on the GPInput0 pin 
(threshold = 2.0V) of the DPhy Decoder back-panel connector.  Note: firmware 
version 2.3 or higher is required for this function. 

 GPInput1 – Sets the trigger flag on a rising edge input on the GPInput1 pin 
(threshold = 2.0V) of the DPhy Decoder back-panel connector.  Note: firmware 
version 2.3 or higher is required for this function. 

4.2.2.1 Packet Fields Triggering 
When triggering based on packet fields, triggering is a two stage process.  The first stage 
selects the set of packets based on packet type for further evaluation.2  The second stage 
then evaluates these qualifying packets using the designated predicate terms and trigger 
equation to determine the trigger flag state. 

4.2.2.1.1 Stage 1 Trigger Selection 
The first stage selection process of packets for trigger evaluation uses the Trigger Pkt 
Types which is a checked tree-view containing all packet types.  Top-level nodes in the 
tree-view consist of categories of packet types and second-level nodes in the tree-view 
represent the packet types themselves.  Category nodes are not able to be checked by the 
user, but they are checked by software to show that at least one sub-node within the 
category is checked.  

                                                 
2 Note that both HS packets and LPDT packets are considered for triggering in this mode, 
but only if Escape Mode is enabled. Otherwise only HS packets are considered. 
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To select a packet type to be included in trigger evaluation, the user simply opens the tree 
node category (if closed) and checks the desired packet type.  Note that in this mode, if 
no packets are selected, no trigger will result, regardless of the trigger equation settings. 
 
 For DSI, the top-level categories are: 
 
 Generic Commands 
 DCS Write Commands 
 DCS Read Commands 
 Read Response Commands 
 Packed Pixel Stream Commands 
 Custom Commands 

 
For CSI, the top-level categories are: 
 
 Generic Commands 
 YUV Commands 
 RGB Commands 
 Raw Commands 
 User Commands 
 Custom Commands 

 
These categories are mostly self-explanatory, based on the packet type definitions for 
each respective MIPI specification.  The Generic Commands category includes all packet 
types defined in the specification that do not fall in any of the other categories.  The 
Custom Commands category includes user-defined data types using the Custom 
Command dialog (Config -> Define Custom Commands… menu option).   
 
Other button controls in this section are: 

Set All – checks all the packet types in the tree-view 

Clr All – clears all the checked packet types in the tree-view 

Collapse All – collapses all the category nodes in the tree-view 

Expand All – expands all the category nodes in the tree-view 

4.2.2.1.2 Stage 2 Trigger Selection 
Stage-two trigger selection defines the predicates and the trigger equation to be used for 
final trigger evaluation.  Six predicate terms are supported where each term targets a 16-
bit field (byte aligned) starting at any starting byte offset between 0-10.  This byte range 
allow all fields in short packets and long DCS packets with up to three 16-bit arguments 
to be fully supported.  Predicates are defined by masking the field and comparing it to a 
value.  After the predicate terms have been defined, the user specifies a logical trigger 
equation that uses the field comparison results. 
 
The following list describes the controls used for each term definition: 
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 Field – drop-down control identifying some common pre-defined field names. 
Full use of this control is not required, as most entries simply act as a “preset” for 
other controls in the term.  The user can always just select “Custom” to have full 
control over predicate definition (see below).  Note that when defining a 
predicate, the Field value should be selected first, as it will overwrite the other 
term controls with appropriate values.   
 
The first option is always “Unused” which sets the term controls to an always true 
comparison.   This allows it to be included in the default trigger equation (all 
terms ANDed) with no effect.  This selection is merely a convenience for 
readability because the trigger equation actually specifies whether a term is used 
or not and, thus, it is not necessary to set unused terms to this setting.   

 
The second option in the field drop-down control is always “Custom”, which 
enables all the other term controls for arbitrary user settings.   
 
Next, follow common generic packet header fields (i.e. VC, DataType, DataID, 
WordCount, ECC) which initialize the byte offset and mask fields appropriately, 
allowing the user to set the comparison operation and value for the term. 

 
Finally, additional options may be added to the Field control list, varying with the 
selected packet type.  If a single packet type with known fields is selected in stage 
1, then they are added as options here.   

 ByteOff – drop-down control to set the byte offset of the field.  For example, a 
byte offset of 4 would specify the field to be the first two payload bytes of a 
packet.  (Note in this case that all of the selected packets from stage 1 should be 
long packets as byte 4 is not defined for short packets.). 

 Mask – text box to set the mask value.  This value is treated as a 16-bit value and 
ANDed with the packet field before comparison with the term value.  Values are 
parsed as decimal unless appended with an ‘h’, in which case they are parsed as 
hexadecimal (i.e. 20h = 32 decimal).  The LSB corresponds to the earlier byte in 
the packet.  For example, if the mask were set to FF00h with ByteOff == 4, the 
resulting masked value would have packet byte 5 in the MSB and zero in the 
LSB. 

 Op – drop-down control to select the predicate comparison operation.  All logical 
comparisons are supported, i.e. ==, !=, >, >=, <, <=. 

 Value – text-box to set the term comparison value.  Values are parsed as 16-bit 
decimal numbers unless appended with an ‘h’, in which case they are parsed as 
16-bit hexadecimal (i.e. 20h = 32 decimal).   As with the mask value, the LSB 
represents the earlier packet byte.  

 
The final controls used for stage two triggering are the trigger equation specification 
itself and the default button: 
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 Trigger Equation – text box to specify how term predicates should be combined 
in a Boolean equation to determine the final trigger state.  Terms predicates are 
identified using the numbers ‘1’ through ‘6’.  The ‘&’ and ‘|’ symbols for AND 
and OR operations and parentheses can be used to set precedence (e.g. “1 & (2 | 
3) & 4”).   

 Default – button to reset all term controls and the trigger equation to their default.  
The default setting is for all term controls to be “Unused” and the trigger equation 
to be “1 & 2 & 3 & 4 & 5 & 6”. 

4.2.2.2 LP Signal State Triggering 
When triggering based on LP Signal State, the packet field controls are disabled and 
triggering is solely determined by predicate term and trigger equation definition. 3  Please 
refer to section 4.2.2.1.2 for an overview of these controls.   
 
The main difference in this mode versus packet field triggering is that predicate terms 
always operate on a composite value derived from LP records (rather than fields within a 
packet).  This composite value is 10 bits and indicates the current LP state of all lanes 
including the clock lane.  The five 2-bit fields represent the LP state of each lane, where 0 
= LP00, 1 == LP01, 2 == LP10, and 3 == LP11. 
 
 Bit definitions for the fields are as follows: 
 [1:0] lane 0 LP state 
 [3:2]  lane 1 LP state 
 [5:4] lane 2 LP state 
 [7:6]  lane 3 LP state 
 [9:8] clock LP state 

 
For example, a mask of 0x300 and a value of 0x100 define a predicate to test if the clock 
lane is in the LP01 state. 
 
For convenience, the field drop-down control in this mode contains entries for all 
combinations of lane and state, i.e. “Lane0 in LP00”, “Lane0 in LP01”... “Clock in 
LP10”, “Clock in LP11”.  Also, note that the ByteOff field is unused in this mode and is 
thus disabled. 

4.2.2.3 LP Sequence State Triggering 
When triggering based on LP Sequence State, the packet field controls are disabled and 
triggering is solely determined by predicate term and trigger equation definition.3   Please 
refer to section 4.2.2.1.2 for an overview of these controls.  
 
The main difference in this mode versus packet field triggering is that predicate terms 
always operate on the lane zero sequence state.  DPhy defines various LP signaling 
sequences such as BTA, ESCAPE, and HS and triggering is possible on the occurrence of 
any of them.  While each state and intermediate states are represented by a particular field 

                                                 
3 Note that in this mode, if all terms are set to “Unused, triggering is disabled. 
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value, only a few are generally useful.  These particular states – “HS Burst”, “BTA”, 
“BTA Exit” and “Escape Entry” – are available for convenience in the field drop-down 
control. 
 
For completeness, Table 1 documents all the possible sequence states.  Numbers in the 
state names indicate receipt of a particular LP signal value (i.e. 0 = LP00, 1 = LP01, 2 = 
LP10, 3 = LP11).  For example, if the sequence state is LPSTATE_3, lane 0 is currently 
in the LP11 state.  If in LPSTATE_32, lane 0 has seen LP11 followed by LP10. 

Table 1 – Lane 0 Sequence States 
State Value 
LPSTATE_UNKNOWN 0 
LPSTATE_3 1 
LPSTATE_32 2 
LPSTATE_320 3 
LPSTATE_3202 4 
LPSTATE_BTA 5 
LPSTATE_BTA_EXIT 6 
LPSTATE_3201 7 
LPSTATE_ESCAPE 10 
LPSTATE_31 11 
LPSTATE_HS 12 

 

4.2.2.4 Escape Command Triggering 
When triggering based on the Escape Command, the packet field controls are disabled 
and triggering is solely determined by predicate term and trigger equation definition.3   
Please refer to section 4.2.2.1.2 for an overview of these controls.  
 
The main difference in this mode versus packet field triggering is that predicate terms 
only are applied to escape command byte values.   
 
For convenience, the field drop-down control in this mode contains entries for predefined 
escape commands in the DPhy specification.  These are: “LPDT”, “ULPS”, “Reset 
Trigger”, “Trigger 1”, “Trigger 2”, and “Trigger 3”.  The user may also select “Custom 
Escape Cmd” to define other command values. 

4.2.2.5 Skew Calibration Triggering 
When triggering on Skew Calibration, all other trigger controls are disabled.  The trigger 
flag is set for bursts that contain a skew calibration sequence.  

4.2.2.6 CRC Error Triggering 
When triggering on CRC errors, all other trigger controls are disabled.  The trigger flag is 
set for packets that have a CRC error.  
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4.2.2.7 ECC Error Triggering 
When triggering on ECC errors, all other trigger controls are disabled.  The trigger flag is 
set for packets that have an ECC error. 

4.2.2.8 Burst Error Triggering 
When triggering on burst errors, all other trigger controls are disabled.  The trigger flag is 
set for packets that have a burst error which is defined as when either: 
 
1) A valid HS burst entry and exit sequence is seen on a lane but with no valid sync byte 
2) A valid HS burst entry and exit sequence is seen on multiple lanes but sync bytes, if 
present, are not within one byte time of each other. 
 
When a burst error is declared in the disassembly, a single burst error packet is shown 
containing unaligned data for all active lanes.   

4.2.2.9 Any Error Triggering 
When triggering on any errors, all other trigger controls are disabled.  The trigger flag is 
set for packets that have a burst error, ECC error, or CRC error. 

4.2.2.10 Trigger Immediately 
When triggering immediately, acquisition begins immediately after the Run button is 
clicked.  The trigger flag is not set for any packet. 

4.2.2.11 Trigger On GPInput0 
When triggering on GPInput0 (an input on the back-panel connector of the DPhy 
Decoder), all other trigger controls are disabled.  The trigger flag is set for records that 
have a rising edge in bit 0 of the GPInp disassembly group.  Note: firmware version 2.3 
or higher is required for this function. 

4.2.2.12 Trigger On GPInput1 
When triggering on GPInput1 (an input on the back-panel connector of the DPhy 
Decoder), all other trigger controls are disabled.  The trigger flag is set for records that 
have a rising edge in bit 1 of the GPInp disassembly group.  Note: firmware version 2.3 
or higher is required for this function. 

4.2.3 Receive Tab Page Controls 
The receive control page is one of two tab pages occupying the right side of the main 
window.  To show the page, click on the Receive tab at the top. 
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Figure 3 – Receive Controls 
 
Receive controls only apply when the instrument is in receive-mode (i.e. the “Receive 
Mode” check-box in the main window configuration pane is checked).  These controls 
(see Figure 3 – Receive ControlsFigure 3) configure two behaviors in receive-mode: 
 

1. How the instrument responds to an incoming BTA on the bus.  The user can 
define up to a 128 LP-transition sequence using the Response Msg text box that is 
transmitted whenever a BTA is received.  The following transmit rules are used: 

 Values are always treated as hexadecimal, e.g 100 => 0x100 

 Values between 00 and FF inclusive are treated as hex bytes to send as 
Spaced One-Hot coded LP transitions (each byte requires 16 LP 
transitions). 

 Values between 100 and 103 inclusive are treated as individual LP 
states to transmit, with 100 corresponding to LP00, 101 corresponding 
to LP01, etc. 

 A value of -1 can be used in the ECC byte position for automatic 
calculation of the ECC value. 

 The period of each LP state transmitted is determined by the LP State 
Period control setting (truncated to the nearest 5 ns). 
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 If “Auto LPDT Response” is checked, pre- and post- signaling for an 
LPDT packet response will be automatically sent (see Auto LPDT 
Response control description below). 

 
2. How the instrument terminates lanes (SMA inputs only).  Basically, the user can 

force each lane’s termination on/off or allow the instrument to turn on termination 
automatically during HS bursts as according to the DPhy specification (see 
Custom Terminations control description below). 

 
The following describes the receive-mode controls: 

 Response Msg – text box describing the response sequence to transmit on 
lane 0 after receiving a BTA.  The user provides a list of integer values in 
the text box, separated by spaces, controlling the LP signal states that are 
transmitted.  See rules above for values in list.  For example, a read-
response packet could be sent using the string “12 0 0 -1”. 

 Auto LPDT Response – check-box that indicates the response is intended 
to be an LPDT command (common case).  When enabled and a BTA is 
received on the bus, the instrument will automatically send the BTA 
acknowledge sequence (LP10 LP11) followed by the escape-entry 
sequence and LPDT escape command before the user-defined sequence is 
sent.  In addition, following the user-defined sequence, a return BTA is 
automatically sent.   If Auto-LPDT response is not checked, the user must 
provide all LP signaling and spaced one-hot data (if desired) 

 LP State Period – up/down control to set the duration of each transmitted 
LP state.  When used, the value is truncated to the nearest 5 ns boundary.  
Generally, this should be set to the DUT’s T(LPX) period for proper BTA 
handshaking. 

 Custom Terminations – check-box to enable custom terminations settings.  
When enabled, controls to force terminations on/off for each lane are enabled as 
well as controls to select “Auto”, which enable normal HS burst termination 
behavior.  When the check-box is disabled, “Auto” termination mode is set for all 
lanes.     

4.2.4 Status Controls 
When connected to a DPhy Decoder HS instrument, the status control section provides 
continuously updated statistics about bus activity monitored by the instrument.  Status 
updates occur about once a second. 
 
The status display generally falls into three categories: activity, statistics, and statistics 
control.  

4.2.4.1 Activity 
The activity display at the bottom of the status pane shows graphically the LP and HS 
activity occurring on each lane.  The following notes describe the activity display: 
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 Activity for the LP+, LP-, and HS signals or each lane is represented by an 
indicator graphic. 

 The top row for LP activity consists of 10 indicators, a pair for each lane, with the 
left indicator in each pair representing LP+ and the right indicator representing 
LP-.   

 The bottom row for HS activity consists of 5 indicators, one for each lane. 

 Indicators can be low (low horizontal bar), high (high horizontal bar), or 
transitioning (vertical bar with arrows on both ends).  

 The indication spans the period since the last status update, so for example, if a 
toggling indicator appears, it means that the signal transitioned at least once since 
the last update. 

 Indicators are valid and updated even if the acquisition pipeline is stalled waiting 
for an event (i.e. instrument Output is inactive -- for example, while in delta mode 
with no timeout and a quiescent bus). 

4.2.4.2 Statistics 
The predominant part of the status control section consists of on-going, real-time 
statistics about data traffic on the DPhy bus. Each statistic is summarized below: 
 
The ECC byte in packet headers check the integrity of the packet header.  The ECC is 
tested for packets sent in both HS and LPDT mode if Escape Mode is enabled.  
Otherwise, the ECC is tested (and errors can be triggered on) only in HS packets.  
Controls and statistics relating to ECC status are: 
 

 ECC Error – LED-control indicating whether an ECC error occurred since the 
last update.  If red, an error occurred; if green, no error occurred. 

 Sticky ECC Error – LED-control indicated whether an ECC error occurred since 
the last clear event.  If red, an error occurred; if green, no error occurred. 

 ECC Error Cnt – counts the number of ECC errors that occurred since the last 
clear event.4 

 
The CRC bytes at the end of long packets check the integrity of the packet payload for 
long packets.  The CRC is tested for packets sent in both HS and LPDT mode if Escape 
Mode is enabled.  Otherwise, the CRC is tested (and errors can be triggered on) only in 
HS packets.  Controls and statistics relating to CRC status are: 
 

 CRC Error – LED-control indicating whether a CRC error occurred since the 
last update.  If red, an error occurred; if green, no error occurred. 

 Sticky CRC Error – LED-control indicated whether a CRC error occurred since 
the last clear event.  If red, an error occurred; if green, no error occurred. 

                                                 
4 Note when any of the ECC, CRC, or Trigger counts reach 999 million, they are all reset to zero and 
continue counting. 
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 CRC Error Cnt – counts the number of CRC errors that occurred since the last 
clear event.4  

 
A burst error is declared when the instrument cannot find an HS sync byte in all active 
lanes of an HS burst occurring “nearly” synchronous to each other.  In this case, the 
instrument cannot decode or trigger on packets in the burst.  Controls and statistics 
relating to burst error are: 
 

 Burst Error – LED-control indicating whether a burst error occurred since the 
last update.  If red, an error occurred; if green, no error occurred. 

 Sticky Burst Err – LED-control indicated whether a burst error occurred since 
the last clear event.  If red, an error occurred; if green, no error occurred. 

 Burst Error Cnt – counts the number of burst errors that occurred since the last 
clear event.4  

 
The trigger flag is set whenever the conditions defined by the trigger controls are met.  
Controls and statistics relating to trigger status are: 
 

 Trigger – LED-control indicating whether a trigger event occurred since the last 
update.  If light blue, a trigger occurred; if green, no trigger occurred. 

 Sticky Trigger – LED-control indicated whether a trigger event  occurred since 
the last clear event.  If light blue, a trigger event occurred; if green, no trigger 
occurred. 

 Trigger Cnt – counts the number of trigger events that occurred since the last 
clear event.4  

 
Packet count statistics summarize the number of occurrences of each type of packet.5  
Statistics relating to packet counts are: 
 

 Short Pkt Cnt – counts the number of short packets since the last clear event. 

 Long Pkt Cnt – counts the number of long packets since the last clear event. 

 LP Pkt Cnt – counts the number of LS packets since the last clear event. 

 HS Pkt Cnt – counts the number of HS packets since the last clear event. 

 Total Pkt Cnt – counts the total number of packets since the last clear event. 

 

Lastly, other miscellaneous statistics provided are: 
 

 HS Active Lanes – Indicates the maximum number of lanes that were part of an 
active HS burst since the last clear event.  If zero, no HS packets were seen. 

                                                 
5 Note when any of these packet counts reach 999 million, all counts reset to zero and continue counting.   
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 Meas. HSClk – Indicates the measured HS clock over a relatively short time 
period (milliseconds).  If “Auto HS Freq” is checked, this measurement is used to 
update the “HS Clk Rate” setting (if it differs by more than 10%).   

 Bus Owner – Indicates the current owner of the DPhy bus (Host or Device).  It is 
possible for this state to be incorrect, for example, if the instrument or devices are 
powered on or reset when the DUT owns the bus (or if invalid LP traffic is seen). 
Please verify that the indicator is correct before starting an acquisition or if 
ongoing unexpected errors are seen.  Pressing the Send button causes the bus 
owner to be reset to Host 

 Recv Read Cnt – Indicates the number of BTA cycles seen since the last clear 
event. 

4.2.4.3 Statistics Control 
Three buttons control how statistics are displayed:  
 

 Clear – resets all statistics to zero.  The clear function is also automatically 
applied when the Send button is pressed or when in Auto HS Freq and the 
detected frequency changes by more than 10 MHz. 

 Hold / Resume – suspends or resumes statistics update.  The button label 
alternates with each click, indicating the function to be performed when next 
pressed.  For example, when “Resume” is displayed, statistics update is halted 
until the button is pressed. 

 Totals / Per Iter –  shows total counts or per update counts.  The button label 
alternates with each click, indicating the function to be performed when next 
pressed.  For example, when “Totals” is displayed, all statistics except for the 
sticky errors and trigger, summarize activity only since the last update (rather than 
since the last clear).   

4.3 Disassembly Window 
The disassembly window uploads, decodes, and displays captured records from the DPhy 
Decoder instrument.  This window can be brought up from the main window by clicking 
on the “Show Disasm” button in the Trigger pane (center screen). 
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Figure 4 – Disassembly Window 
Figure 4 shows a disassembly listing showing the capture of a DSI video sequence.  The 
control areas of the disassembly window can be broken down as follows: 
 

 Run/Stop Button – This button at the top-right of the window controls the start 
of acquisition.  It can force a trigger if desired and can also be used to abort long 
processing tasks.  Depending on the current processing state, its name may 
display “Run”, “Stop”, or “Abort”. 

 Listing Grid – The listing grid is the central feature of the disassembly window.  
It contains decoded records and their fields. 

 Cursor Status Display – The top part of the window shows a text read-out of the 
two cursor locations (time relative to start of trace).  The time delta between the 
two cursors is also displayed.  In addition, if one or more disassembly rows are 
selected, the total time for the selected rows is displayed. 

 Cursor Control Panel – The cursor panel is a control next to the vertical scroll 
bar of the listing grid (far right) that spatially indicates relevant locations in the 
trace, specifically: trigger location, cursor locations, and current view location.   

 Disassembly Control Panel – The tabbed control beneath the listing grid 
contains all the controls associated with disassembly.  Separate tab pages provide 
controls for acquisition and disassembly options, filtering and searching 
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disassembly records, and the display of video frame and packet information 
contained in the trace capture. 

4.3.1 Run/Stop Button 
When the DPhy Decoder is connected and monitoring activity on a DPhy bus, clicking 
the Run button initiates an acquisition.  Acquisition is configured via the Options tab 
page of the disassembly control panel, in particular, how much memory to use and where 
the trigger should occur relative to records in the trace (see section 4.3.4.1).   
 
The acquisition process has several phases: 

 Prefill – memory is “prefilled” with data records before the trigger criteria are 
evaluated.  This allows placement of the initial trigger record position in the 
overall trace capture (e.g. at the start, in the middle, near the end, etc).   

 

 Trigger – trigger criteria are evaluated.  While waiting for the trigger condition to 
evaluate true, prefill records continue to be acquired, discarding the oldest 
captured records to make room for new records.  During this time, the status 
displayed in the status bar will be “Waiting for trigger…”.   Also, the label of the 
Run button will change to “Stop”.  Clicking the Stop button will force a trigger 
condition, moving the process to the next phase (Capture). 

 Capture – capture memory is filled with data records.  During this time, the 
status displayed in the status bar will be “Waiting for capture buffer to fill…”.  In 
some capture configurations (e.g. if “Idle Timeout” is zero and quiescent lane 
activity), it is possible for acquisition to stall waiting for data.  In this case, the 
user can click the “Stop” button to complete acquisition with the records that have 
been captured.  Be aware that this will leave some valid data un-captured in the 
processing pipeline (set “Idle Timeout” to ensure a complete capture). 

 Upload – capture memory is uploaded from the DPhy Decoder instrument into 
application memory.  Upload speeds for USB2 are about 20 MB/s and up to 10x 
faster for USB3.  During this phase, the Run button label will be set to “Abort” .  
Clicking the Abort button halts upload and discards any partially uploaded data. 

 Decode – captured records are decoded and displayed in the listing grid.   
Generally, this is a fairly quick process, though depending on the filter and 
disassembly settings, record content, and the number of captured records, this can 
take some time.  Progress is indicated via the status bar, with “Building 
records…” and a percent complete.  The Run button label remains set to “Abort” 
for the user to request a halt to decoding.  If aborted, partial results are displayed.6 

4.3.2 Listing Grid 
The listing grid displays one disassembly record per line, arranged in order from earliest 
in time at the top to latest in time at the bottom.  Generally, only a subset of records is 
shown in the listing at any time, based on settings in the filter tab of the disassembly 

                                                 
6 In the event that the user wants to obtain a full decoding after aborting, clicking the “Reanalyze” button in 
the Options tab reinitiates decoding. 
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control panel, the global mnemonic view state, and the individual mnemonic view state 
for packets.7    
 
Please note there is a distinction between data records acquired by the hardware and 
disassembly records displayed in the listing grid.  For LP data records, there is a one-to-
one correspondence between data records and disassembly records.  For HS data records, 
the correspondence varies depending on what part of the HS burst is being displayed.  
Generally, one disassembly record is used to display one packet byte (for one lane) or one 
one non-packet byte (for all active lanes).  For the remainder of this document, unless it is 
clear from context, the term “record” will refer to a disassembly record.  
 
Columns in the grid represent data fields associated with records, whether direct content 
acquired from the DPhy bus, derived data from that content, or other attributes created by 
the application.  Not all fields apply to all record types, in which case a field will 
generally contains dashes. 
 
The listing grid contains vertical and horizontal scroll bars for scrolling visible rows and 
columns in the grid.  Other mechanisms are available for scrolling or selecting viewable 
rows in the listing including: key strokes, clicking in the cursor panel, selecting among 
several context menu options, and buttons in the search and video tabs of the disassembly 
control panel.   

4.3.2.1 Column and Row Manipulation 
The user has control over what columns are displayed, how they are ordered, and how 
field data are formatted in the column grid.  Columns consist of a header in the first row, 
a radix selection in the second row, followed by field data starting with the third row.  
The following sections outline field- or column-related functions. 

4.3.2.1.1 Selecting Columns 
Similarly, single columns can be selected by right-clicking on the column header (i.e. the 
field name of a column).  A contiguous region of columns can be selected by first 
selecting a column then selecting a second column while holding the shift key down.  In 
addition, a discontinuous set of columns can be selected by clicking while holding the 
control key down.  When a set of columns is selected, certain options in the column 
context menu will apply to each column, e.g. “Delete Columns”, “Restore Select Column 
Width(s)”    

4.3.2.1.2 Selecting Rows 
Single rows can be selected by right-clicking on the row header (i.e. the Sample field of a 
record).  A contiguous region of rows can be selected by first selecting a row then 
selecting a second (later) row while holding the shift key down.  Once selected, rows can 
by copied to the clipboard with Ctrl-C or the “Copy Selected Rows” menu option in the 
Edit menu.  The total time occupied by the selected rows is shown in the Cursor Status 
Display at the top of the disassembly window associated with the field text “Sel:”. 

                                                 
7 These concepts are described further later in this section. 
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4.3.2.1.3 Measuring Time Between Events 
There are two methods to measure time between two events in the disassembly.  The first 
is to use cursors as follows: 
 

1. Right-click on a cell in the row associated with the first event and select “Move 
Cursor1 Here” 

2. Right-click on a cell in the row associated with the second event and select “Move 
Cursor2 Here” 

3. The time between events is displayed in the “Delta” field of the Cursor Status 
Display at the top of the disassembly window. 

 
The second method uses row selection as follows: 
 

1. Left-click on the Sample cell in the row associated with the first event 
2. Left-click on the Sample cell in the row associated with the second event while 

holding down the Shift key 
3. The time between events is displayed in the “Sel” field of the Cursor Status 

Display at the top of the disassembly window. 
 

4.3.2.1.4 Add Column(s) 
To add a column field in the listing grid, right-click on a column header and select the 
“Add Column(s)” menu option to bring up the Add Column dialog.  Check the desired 
column fields to display and click OK. 

4.3.2.1.5 Remove Column(s) 
To remove a column field in the listing grid, select one or more columns and press the 
Delete key.  Alternatively, right-click in one of the selected column headers and choose 
“Delete Column(s)”.  If multiple columns are to be deleted, the user is asked for 
confirmation. 

4.3.2.1.6 Reordering Columns 
To change the display order of a visible column, right-click and drag the column header 
to a new position.  Also, you can also first select a group of columns and then right-click 
and drag them.  Discontinuous groups that are moved aremade contiguous after dragging. 

4.3.2.1.7 Setting Column Widths 
Column widths are automatically set to accommodate the widest string or value to be 
displayed and are updated whenever the field radix is changed.  However, the user may 
adjust column width by selecting the right edge of a column header and dragging it.  A 
column’s width may be restored to its default using the column context menu option 
“Restore Selected Column Width(s)” or simply double-clicking on the column header.   

4.3.2.1.8 Setting the Field Radix 
Most fields are numeric and have an underlying value associated with it (Boolean fields 
are also numeric and are associated with a 0 or 1 value).  Numeric fields can be displayed 
as binary, decimal, or hexadecimal by right-clicking the radix context menu of a 
particular column sub-header (second row in grid).  In addition, some fields have a 
default symbolic association -- basically a built-in number-to-string mapping -- that may 
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be available in the menu.  Finally, a user can define a custom symbol file to use for 
number-to-string translation (see section 4.3.2.1.10). 

4.3.2.1.9 Setting the Time Field Reference 
The time field displays the time-stamp of a record, indicating when the data was acquired 
relative to the start of trace capture (see section 4.3.2.2.4).  DPhyDecoderHSCtl supports 
viewing time-stamps relative to a global time reference selected by the user via the radix 
context menu associated with the time field.  Records occurring before the global time 
reference have a negative time field value and records occurring afterwards have a 
positive time field value. 
 
The following time field display options are provided in the Time radix context menu: 

 Relative to Start – display time-stamps relative to the first record. 

 Relative to Trigger – display time-stamps relative to the trigger record 

 Relative to Cursor1 – display time-stamps relative to cursor1 

 Relative to Cursor2 – display time-stamps relative to cursor2 

 Relative to Previous – display time-stamps relative to the preceding visible record 

4.3.2.1.10 Defining and Using a Symbol File 
To associate a radix file to a numeric field, select the “<New Symbolic File>” option in 
the radix context menu.  This brings up an open file dialog to browse for and select the 
new symbol file.  Once the symbol file has been selected, the context menu will enable 
the “Symbolic (File)” option (and it will be checked). 
   
Symbol files are text files containing number-to-string mappings, where each mapping 
consists of a Boolean predicate equation and a string.  During disassembly, the equation 
from each mapping is evaluated in order for each field value and the string from the first 
mapping whose equation evaluates true is displayed. 
 
Predicate equations consist of one or more terms, one term per line.  In multi-term 
equations, all but the last term in the equation are followed by “AND” or “OR” forming a 
Boolean equation from the terms.  Finally, the last term of a predicate equation is 
followed by a colon, and then the symbolic string to associate with the equation enclosed 
in quotes.   
 
Each predicate term consists of a relational operator and a value.  Relational operators are 
“>”, “<”, “>=”, “<=”, “==”, and “!=”.  Values are interpreted as decimal unless an ‘h’ or 
a ‘b’ is appended to denote hexadecimal or binary respectively.  In addition, for hex or 
binary values, the character ‘x’ may be used as a “don’t care” digit (if the first character 
is an ‘x’ it represents don’t care digits up to the width of the field)  
 
For example, the following lines define a predicate equation to detect values between 
0x10 and 0x40 or if a value is odd: 
 
 // predicate equation 

>   10h   AND 
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<   40h   OR 
== x1b   :    “Range between (10h, 40h) or odd” 

 
For values in the disassembly where this equation evaluates true, the string “Range 
between (10h, 40h) or odd” will be displayed.  
 
Some notes about symbol file usage: 

 Note that blank lines and lines that begin with “//” (which can be used for 
comments) are ignored by the parser.   

 Predicate terms are interpreted as a sum-of-products equation and so AND has 
higher precedence than OR.  Thus, predicates that describe the equation “a AND 
b OR c AND d” is parsed “(a AND b) OR (c AND d)”. 

 White space is required between the relational operator, the value, the “AND”, 
“OR” and “:” delimiters, and the string. 

 Mappings are evaluated in order, so subsequent predicate equations do not need to 
exclude values that would have already satisfied prior mappings. 

 If not mapping qualifies for a value, a string with “?” is displayed.  To avoid this, 
a default mapping can be appended to the end of the symbol file with the catch-all 
predicate “>= 0”. 

4.3.2.2 Field Descriptions 

4.3.2.2.1 Mnem Field 
The mnemonic field is a symbolic-only field that conveys the record type.  The string 
displayed in this field can be customized to tabulate and show certain other fields in the 
record and their values.  This behavior is configured using the “Mnem Cfg…” button on 
the Options tab of the disassembly control panel.  Using this feature is simply another 
way to view fields in a record, using the mnemonic column to display the field rather 
than using a separate column in the listing. 

4.3.2.2.2 Sample Field 
The Sample field represents a record’s ordinal number in the listing (i.e. essentially the 
disassembly record number).  Gaps in the sample number generally indicate that there are 
records not displayed in the current view, though there are some sample numbers that are 
never displayed (the values are used internally but not meant for display). 

4.3.2.2.3 Disp Field 
The Disp field is a column used for showing the mnemonic view state of packet headers.  
A “packet” from a disassembly point-of-view includes not only protocol packets but 
escape packets and other data groupings such as a skew calibration, burst error data, and 
burst data in when sync detection is disabled (called HS Raw packets).  A “packet 
header” from a disassembly point-of-view is the first record in the disassembly associated 
with a packet. 
 
This “Disp” field is blank for non-packet byte records but contains one of three indicators 
for a record containing a packet header: “+”, “++”, or “-“.  These indicators correspond to 
a mnemonic view state of “closed”, “mnem-fields”, “mnem- and packet-fields” 
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respectively.  When clicked, the mnemonic view state of the packet cycles to the next 
state (see section 4.3.2.5).   
 
Note: the mnemonic view state of all packets can be forced by clicking in the second row 
of the Disp column, which is usually the Radix row but for the Disp column contains “+”, 
“++” and “-“ indicators that can be clicked to cycle the global mnemonic view state.   

4.3.2.2.4 Time Field 
The Time field represents displays a record’s time-stamp, which the user may choose to 
display relative to a number of time references (e.g. start of trace, cursor or trigger 
position, etc.)  Please see section 4.3.2.1.9 for more information.   
 
By default, the time-stamp is displayed with a radix of Symbolic (Default), which 
displays the time as a string, e.g. “1.300 ns”, but alternatively it may be displayed as a 
numeric value (hex or decimal), which converts time to an integer number of 
picoseconds.  This allows the time field to be used in search and filter criteria, for 
example, in restricting record display or search to a limited time range.8 

4.3.2.2.5 Param Fields 
In the MIPI CSI-2 and DSI, many packet types are associated with one, two or three 
named parameter fields (as opposed to larger blocks of generic data such as pixel data, 
blanking bytes, LUT tables, etc.).  The disassembly window organizes these packet 
parameters into the fields: “Param1”, “Param2” and “Param3”.   
 
For example, the Generic Short Write packet can have 0, 1, or 2 parameters.  For zero-
parameter writes, all Param fields will have dashes displayed in them.  For one-parameter 
writes, “Param1” will display the value of the single-byte parameter.  And for two-
parameter writes, “Param1” and “Param2” will display the single-byte parameters.  
 
Another example is the DCS Set Column Address command that has two 16-bit 
parameters.  In this case, “Param1” and “Param2” will display the 16-bit StartColumn 
and EndColumn parameters respectively.  
 
Finally, note that when the Param fields are added as mnemonic fields using the “Mnem 
Cfg…” button, the actual parameter names are displayed in the mnemonic.  For this 
reason, in general, the user may find it convenient to have the Param fields selected as 
fields to display in the mnemonic.   

4.3.2.2.6 LPSeq Field 
The LPSeq field indicates the LP sequence state of the DPhy Decoder at the time the 
record was recorded.  The LP sequence state represents a position in decoding DPhy LP 
signaling, for example, the state LP-320 records having seen the sequence LP11, LP10, 

                                                 
8 Currently, searching or filtering on the time-stamp field when in symbolic mode may not behave as 
expected, as comparisons are made alpha-numerically in this radix. 
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LP00 (the first three signaling states of a BTA).  The following LP sequence states are 
used:9 
 

State LP Seq 
LP-Unk Non-LP11, invalid or unknown sequence state 
Stop  LP11 
LP-Rqst LP11, LP10  
LP-320 LP11, LP10, LP00 
LP-3202 LP11, LP10, LP00, LP10 
BTA LP11, LP10, LP00, LP10, LP00 
BTA-Exit LP11, LP10, LP00, LP10, LP00, LP10 
LP-3201 LP11, LP10, LP00, LP01 
LP-Esc LP11, LP10, LP00, LP01, LP00 
LP-Esc-Exit LP11, LP10, LP00, LP01, LP00, LP10 
HS-Rqst LP11, LP01 
HS-Prepare LP11, LP01, LP00 
HS In HS burst 

4.3.2.2.7 PktLen Field 
The PktLen field applies to records that show the first byte of a packet and indicates the 
total number of bytes associated with the packet (including header and CRC fields). 

4.3.2.2.8 VC Field 
The VC field applies to records that show the first byte of a packet and displays the 2-bit 
virtual channel field of the packet. Error! Bookmark not defined. 

4.3.2.2.9 DataType Field 
The DataType field applies to records that contain the first byte of a packet and displays 
the 6-bit data type field of the packet. Error! Bookmark not defined. 

4.3.2.2.10 DCSCmd Field 
The DCSCmd field applies to records that contain the first packet byte of a DCS read 
request short write, or long write and displays the 8-bit DCSCmd field.   

4.3.2.2.11 LP Fields 
There are five LP fields: “LP0”, “LP1”, LP2”, “LP3” and “LPClk”.  These fields are 
present in all record types and reflect the LP lane state of lanes 0-3 and Clk respectively.  
Note that unused lanes (i.e. those exceeding than the maximum lane count setting - 1) 
always show the LP11 state, even if the lane input is disconnected.  A default SymDef 
mapping is provided to map field values of 0-3 to LP00, LP01, LP10, and LP11 
respectively.  . 

4.3.2.2.12 Data Fields 
There are four Data fields: “Data0”, “Data1”, “Data2”, “Data3”.  These fields show the 
data byte value per lane associated with the record.  HS records will display bytes in the 
Data fields associated with active lanes.  They will also show data bytes associated with 
                                                 
9 Note that the DPhy Decoder does not distinguish between the LP00 state called HSPrepare and the HS-0 
state called HSZero.  The sequence state for this period is called HS-Go. 
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HS-Zero, HS-Sync and HS-Trail states (fractional bytes are not displayed).    On the 
other hand, only Data0 may show LP data bytes, including LPDT packet bytes, as well as 
escape and trigger byte codes associated with the escape signaling protocol. 

4.3.2.2.13 Trig Field 
The Trig field applies to all record types and is a Boolean value (0 or 1) that represents 
the result of trigger criteria evaluation for the record.  There is no limit to how many 
records may have their Trig field set.  Moreover, non-zero prefill settings may mean the 
record associated with the hardware trigger event is not the first record with Trig == 1 in 
the trace.  If it is important, use the Cursor Panel or context menu to go to the record 
associated with the hardware trigger record (i.e. the record triggering acquisition).  A 
default SymDef mapping is provided to map field values of 0 to “---“ and 1 to “Trig”.  

4.3.2.2.14 Frame Field 
The Frame field applies to records that contain the first packet byte of all video-related 
packet types, including CSI Frame Start, Frame End, Line Start, Line End;  DSI VSync 
Start and VSync End; blanking and video packets.  Starting at one, it reflects an ordinal 
frame number associated with the packet.  It also corresponds with frames listed in the 
video tab of the Disassembly Control panel.  Generally, the frame number will increment 
with each Frame Start or VSync Start packet, but might otherwise increment if a video 
packet occurs with a new VC or DataType.  

4.3.2.2.15 ActLine Field 
The ActLine field applies to records that contain the first packet byte of an active video 
packet, where a preceding Frame Start or VSync Start packet has already been seen 
(otherwise, the line number is unknown).  Starting at one, it reflects the active line 
number of the packet in the frame. 

4.3.2.2.16 Lane Field 
The Lane field applies to all records and indicates the corresponding data lane of its data 
byte.  For LP records, Lane field is always zero.  For HS records, the Lane field can be 0 
through the maximum lane count minus 1. 

4.3.2.2.17 ECC Fields 
There are three ECC fields: “ECC”, “ExpECC”, and “ECCOk”, displaying the ECC byte 
contained in a packet header, the expected (computed) ECC bytes associated with the 
header, and a comparison result of the two respectively.  These fields apply to records 
that contain the first packet byte.  ECCOk has a default SymDef mapping for the boolean 
comparison of 0 == “Err” and 1 == “Ok”. 

4.3.2.2.18 BusOwn Field 
The BusOwn field applies to all DSI records and indicates which end of the bidirectional 
link is transmitting (i.e. owns the bus).  A default SymDef mapping for the Boolean value 
is 0 == “Dev” and 1 == “Host”.    

4.3.2.2.19 BurstErr Field 
The BurstErr field displays whether or not a packet is a burst error packet.  A default 
SymDef mapping for the Boolean value is 0 == “---“ and 1 == “Err”.  
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4.3.2.2.20 GPInp Field 
The GPInp field is a two bit field showing the signal levels of the GPInput0 (bit 0) and 
GPInput1 (bit 1) signals on the back-panel connector of the DPhy Decoder instrument.  
This signal is only time-accurate to within about 15 ns + 32 UI.  Note that the field is 
only supported for firmware version 2.3 and higher. 

4.3.2.3 Trigger and Cursors 
The hardware trigger record and two cursor records can be displayed in the listing grid, 
changing the background highlighting of their associated records.  The trigger record 
indicates the location of the hardware trigger for capture and is a static fixed position that 
cannot be changed but can be used as a reference for time measurement and Goto 
operations.  Its Trig field will be set to 1, though it may not be the only record with Trig 
== 1, nor is it necessarily the first occurrence of a record with Trig == 1, depending on 
the Prefill percentage setting.  
 
Cursors are enabled by checking the associated checkbox in the top of the cursor panel to 
the right of the listing grid and can be controlled from the cursor panel control (see 
Cursor Panel section for more details).  The current cursor positions and the delta time 
between them are displayed above the listing grid, using the current global time reference 
set in the time field radix context menu.     
 
Cursor related functions are also available in the column context menu available by right-
clicking in any grid cell (except the radix sub-header row).  In particular, the user can 
select “Goto Cursor1” or “Goto Cursor2” to scroll the listing grid to the record location 
of the indicated cursor.  Also, if the context menu is brought up from a non-header cell, 
the “Move Cursor1 Here” and “Move Cursor2 Here” options are also available. 

4.3.2.4 Disassembly View Content 
A main feature of the disassembly window is to allow the user to set criteria for filtering 
records, only displaying a subset of acquired records from the disassembly view.  This is 
done through several mechanisms: enabling/disabling LS/HS signaling, adjusting the 
global mnemonic view or the mnemonic view of individual packets, and setting packet 
and record filter criteria.  Each mechanism successively restricts records shown in the 
disassembly. 
 
A main option for controlling the disassembly view content is the “Show LP/HS 
Signaling” check-box on the Options tab of the Disassembly Control Panel.  Disassembly 
is affected by the check-box state as follows: 
 

 Checked: shows all record types, including non-packet traffic such as LP records, 
and HS signaling record types such as. HS-Zero, HS-Sync, and HS-Trail. 

 Unchecked: hides all record types except for packet records, which include HS, 
LPDT, escape, burst error, HS raw, and skew calibration packets. 

 
When the option is changed, the listing is updated to display records only applicable to 
the new criteria.  In the case of packet records, the mnemonic view state determines 
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whether only the first packet byte is shown or all packet bytes are shown (see next 
section).   

4.3.2.5 Mnemonic View State 
Mnemonic view state is an attribute of packets that affects how the packet is displayed in 
the disassembly listing.  Its setting determines whether only the first byte of a packet is 
displayed, or all bytes of the packet are displayed, and whether the user-specified 
mnemonic fields associated with the packet are displayed.    
 
There are three mnemonic view states:  
 

Closed Only the first packet byte is displayed. 

Mnem-Fields Only the first packet byte plus its mnemonic fields 
are displayed. Mnemonic fields are fields selected 
by the user to be displayed with the mnemonic via 
“Mnem Cfg…” button). 

Mnem-and 
Packet-Fields 

All packet bytes are displayed.  Mnemonic fields 
are also shown for the first packet byte.  

 
The mnemonic view state of a packet is shown in the Disp field in the record using the 
indicators “+”, “++”, or “-“ (corresponding to the states in order in the table above).  To 
cycle an individual packet’s mnemonic view state, click on the indicator in the Disp 
column.  To cycle all packet mnemonic view states at once, click the indicator in the 
second row of the Disp Column (i.e. Radix row).   

4.3.2.6 Column Context Menu 
The column context menu is brought up by right-clicking in any cell except for the radix 
row (second row) of the listing grid.  Depending on the cell location clicked to bring up 
the menu, certain options will be enabled or disabled.  Here is a summary of all the 
functions in the column context menu: 
 

Function Description Shortcut

Add Column(s) Brings up dialog to add columns (i.e. make 
fields visible) to the listing grid. 

 

Delete Column(s) Deletes selected columns.  
Restore Selected 
Column Width(s) 

Restores selected columns to their default 
width. 

 

Select All Selects all records in the disassembly Ctl-A 
Goto Cursor1 Scrolls the listing grid to the cursor1 record. Ctl-1 
Goto Cursor2 Scrolls the listing grid to the cursor2 record. Ctl-2 
Goto Trigger Scrolls the listing grid to the hardware trigger 

record. 
Ctl-T 

Goto… Brings up a dialog to enter a sample number 
to scroll the listing grid to (the nearest visible 

Ctl-G 
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record is used). 
Move Cursor1 Here Moves the cursor1 position to the current 

record. 
 

Move Cursor2 Here Moves the cursro2 position to the current 
record. 

 

Search Frame Start Fills in the search criteria to search for Frame 
Start for CSI or VSync Start for DSI.  Then, 
the Next Search function is performed. . 

Ctl-Alt-F 

Search Same Mnem Fills in the search criteria to search for records 
that match the mnemonic value associated 
with the current record.  Then, the Next 
Search function is performed.  Note that the 
current cell can be any field type. 

Ctl-Alt-M 

Search Same Val Fills in the search criteria to search for records 
that match the current cell’s field value.  
Then, the Next Search function is performed. 

Ctl-Alt-V 

Search Same Mnem 
And Val 

Fills in the search criteria to search for records 
that match the mnemonic value associated 
with the current record and the current cell’s 
field value.  Then, the Next Search function is 
performed. 

Ctl-Alt-B 

Next Search Scrolls to the next record satisfying the search 
criteria 

Ctl-S 

Next Packet Scrolls to the next packet start. Ctl-P 
Next Frame Start Scrolls to the next CSI Frame Start or DSI 

VSync Start packet. 
Ctl-F 

Next Same Mnem Scrolls to the next record that matches the 
mnemonic value associated with the current 
record. 

Ctl-M 

Next Same Val Scrolls to the next record that matches the 
current cell’s field value. 

Ctl-V 

Next Same Mnem 
And Val 

Scrolls to the next record that matches the 
mnemonic value associated witht the current 
record and the current cell’s field value. 

Ctl-B 

Prev Search Scrolls to the previous record satisfying the 
search criteria 

Alt-S 

Prev Packet Scrolls to the previous packet start. Alt-P 
Prev Frame Start Scrolls to the previous CSI Frame Start or 

DSI VSync Start packet. 
Alt-F 

Prev Same Mnem Scrolls to the previous record that matches the 
mnemonic value associated with the current 
record. 

Alt-M 

Prev Same Val Scrolls to the previous record that matches the 
current cell’s field value. 

Alt-V 

Prev Same Mnem 
And Val 

Scrolls to the previous record that matches the 
mnemonic value associated witht the current 

Alt-B 
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record and the current cell’s field value. 
Exclude All But 
Frame Start 

Sets and applies the filter criteria to filter all 
records except for CSI Frame Start of DSI 
VSync Start packets. 

Ctl-X, F 

Exclude All But Same 
Mnem 

Sets and applies the filter criteria to filter all 
records except those that match the mnemonic 
value associated with the current record. 

Ctl-X, M 

Exclude All But Same 
Val 

Sets and applies the filter criteria to filter all 
records except those that match the current 
cell’s field value. 

Ctl-X, V 

Exclude All But Same 
Mnem and Val 

Sets and applies the filter criteria to filter all 
records except those that match the mnemonic 
value associated with the current record and 
the current cell’s field value. 

Ctl-X, B 

Modify Filter From 
Current Cell 

Contains a sub-menu with three items: 
 Replace Filter Term 
 Add OR Filter Term 
 Add AND Filter Term 

Selecting one of these menu items will 
perform the requested function based on the 
current cell’s field name and value.  The 
operator used is “==”. 

 

Modify Search From 
Current Cell 

Contains a sub-menu with three items: 
 Replace Search Term 
 Add OR SearchTerm 
 Add AND Search Term 

Selecting one of these menu items will 
perform the requested function based on the 
current cell’s field name and value.  The 
operator used is “==”. 

 

4.3.2.7 Radix Context Menu Summary 
The radix context menu is brought up by right-clicking in the sub-header row (second 
row) of the listing grid and is used to set the display format of the current column.  The 
functions in the menu have been described in earlier sections.  Here is a summary of all 
the functions in the radix context menu (except for the context menu for the Time field): 
 

 Hexadecimal – sets the radix to hexadecimal (enabled for numeric fields) 
 Decimal – sets the radix to decimal (enabled for numeric fields) 
 Binary – sets the radix to binary (enabled for numeric fields) 
 Symbolic (Default) – sets the radix to symbolic using the default translation 

internal to the application. 
 Symbolic (File) – sets the radix to symbolic using the translation defined by the 

symbolic file specified by the user using the “<New Symbolic File>” menu 
option. 
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 <New Symbolic File> – brings up an open file dialog to select a symbol file to 
associate with the current column. 

 
In addition, the time field radix context menu has several more options to set the desired 
time field reference, which determines how the time field is displayed.  One of these 
options is always checked:  
  

 Relative to Start – sets the global time field reference to the first acquired record 
 Relative to Previous – sets the time field reference for each record to the 

previous displayed record (i.e. displays delta time between records) 
 Relative to Trigger – sets the global time field reference to the trigger record 
 Relative to Cursor1 – sets the global time field reference to the cursor1 record 
 Relative to Cursor2 – sets the global time field reference to the cursor2 record 

4.3.3 Cursor Control Panel 
The cursor control panel (cursor panel, for short) is a custom control with three narrow 
columns on the right side of the listing grid.  Each narrow column is similar to a vertical 
scroll bar, each associated with either a cursor or the trigger (for the purposes of this 
description, the trigger can be thought of as a special cursor with fixed position).  Cursors 
represent a specific record position in the listing, similar to a scroll bar, where the top of 
the panel represents the start of the listing and the bottom of the panel represents the end 
of the listing. 
 
The first column in the cursor panel represents the trigger and, if enabled, is drawn as a 
red square labeled with a ‘T’.  The trigger cursor is always enabled.  The second and third 
columns represent cursor1 and cursor2 respectively and, if enabled, are drawn as a blue 
square labeled with a ‘1’ or a blue square labeled with a ‘2’.  A check box above each 
cursor column can be used to enable or disable each cursor.  Disabled cursors are drawn 
with a gray background in the cursor panel and are not visible in the disassembly listing. 
 
Like a scroll-bar, the cursor panel is meant to represent the entire vertical span of the 
listing windows.  Cursor positions within the panel symbolically indicate where each lies 
within the listing, i.e. a cursor toward the top of the panel indicates a record position near 
the start of the listing and a cursor toward the bottom of the panel indicates a record 
position near the end of the listing.  The times associated with cursor1 and cursor2 
positions and the difference between them are displayed in readouts above the listing 
grid.  
 
In addition to the cursor symbols, a horizontal white region is drawn across the cursor 
panel.  This region represents the currently viewed region of the listing, having a position 
and thickness corresponding to the current viewed region relative to the total listing. 
 
Finally, horizontal orange lines are drawn to indicate the occurrence of at least one search 
result in the associated region of the disassembly listing.  If the search record density is 
high enough, this can have the effect of shading the background of entire regions of the 
cursor panel orange. 
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The cursor panel supports the following operations for setting cursor positions and 
scrolling the listing: 
 

 Left-clicking and dragging a cursor square moves the cursor position.  While 
dragging, the current cursor position (Sample #) is displayed in a pop-up box. 

 If the Shift key is pressed and held while dragging, the listing will scroll with the 
cursor position, otherwise the listing will not scroll. 

 If the Control key is pressed and held while dragging, the cursor will scroll more 
slowly, allowing for finer control.   

 Double clicking a cursor in the panel scrolls the listing window to the cursor 
position. 

 Double-clicking in the cursor panel (not on a cursor) scrolls the listing window to 
the position clicked. 

4.3.4 Diassembly Control Panel 
The Diassembly Control Panel is located at the bottom part of the disassembly window 
and has six tabs: Options, Filter, Search, Video, Packets, and <Minimize>.  The functions 
and controls provided by each tab are described in the following sections. 

4.3.4.1 Options Tab Page 
The Options tab contains controls for configuring acquisition, decoding, and disassembly 
display.   

4.3.4.1.1 Acquisition Options 
There are three user-controls for acquisition.  They are described below: 

 Prefill Pct – up/down control that sets the trigger position relative to the 
acquisition.  The value is an integer percentage of the acquisition memory buffer 
size and ranges from 5% to 95%.  Setting the Prefill Pct value to minimum will 
cause the trigger record to appear near the beginning of the trace.  Setting to 50% 
places the trigger record to appear in the middle of the trace.  Etc. 

Because disassembly first requires seeing an LP11 state before decoding, the 
minimum prefill percentage is set to 5%.  Except in extreme cases, this should 
allow enough time preceding a trigger record at the end of an HS burst to include 
an LP record containing LP11 for proper disassembly.  

 Memory Depth – drop-down-box that provides options for setting the size of the 
acquisition buffer.  The size ranges from 1 MB to 1024 MB.  As expected, smaller 
buffer sizes correspond to faster acquisition, upload, decoding, and display.  In 
addition, filter and search functions are faster with smaller traces 

 Allow Trigger Before Prefill – check box that determines whether an acquisition 
is allowed to trigger before the prefill requirement is met.  This option is 
necessary for unique triggers that occur early on in a test.  If unchecked, while a 
trigger event under these conditions might be seen in the real-time statistics, 
acquisition may not occur. 
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4.3.4.1.2 Disassembly Options 
Disassembly controls are provided for configuring trace decoding and disassembly 
display (see Figure 5).   
 
General options, unrelated to protocol are: 

 Grid Font Size – up/down control that increases or decreases the font size of the 
grid display.  Values can range from 6 to 12. 

 Highlight Filter Gaps – check box that sets whether or not filtered records cause 
a double-thick horizontal grid-line to be displayed between visible rows.   

 Disable Disassembly – check box that disables disassembly after acquisition and 
upload.  The main use of this option is for debugging, allowing a trace to be 
acquired that causes a catastrophic error in decoding, saved, and sent to the 
Moving Pixel Company for analysis. 

 Reanalyze – button that restarts decoding and disassembly on the current trace 
data.  This may be needed if initial decoding was aborted before decoding was 
complete (in which case, only a partial disassembly is displayed).  Click on the 
Reanalyze button to restart and complete a full decoding. 

 (Disable Sync Detect) – this check box is not on the Option tab but rather in the 
main application window because it affects real-time processing as well as 
disassembly.  When checked, HS Sync bytes are not recognized by the instrument 
and thus no HS protocol packets are decoded in the disassembly.  Instead, entire 
HS bursts are labeled as “HS Raw” packets and unaligned lane data is presented 
as payload.  This is useful for viewing low-level phy traffic during debugging. 

 

 

Figure 5 – Disassembly Options 
The remaining controls in the Options window are protocol-related options.  They are: 

 Toggle Host/Dev (DSI) – button that toggles the bus ownership flag (i.e. Host or 
Device) for the first record in the acquired trace.  This will rarely be necessary, 
and only if acquisition was made when the instrument has incorrect bus 
ownership state (which should only happen when invalid bus activity confused 
the instrument or in other atypical cases).  Clicking this button will affect how the 
entire acquisition is disassembled as DataType values in DSI represent different 
packet types for the host versus a peripheral. 
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 Mnem Cfg… (CSI & DSI) – button that brings up the Mnemonic Configuration 
dialog, allowing the user to select fields to display with the mnemonic in the 
listing when its mnemonic view setting allows. 

 Show LP/HS Signaling (CSI & DSI) – check-box that selects whether low-level 
LP and HS signaling records are displayed.  When enabled, the disassembly 
shows all LP records and HS records including HS-Zero, HS-Sync, and HS-Trail. 

 Collapse HSZero / HSTrail (CSI & DSI) – check-box that configures how HS-
Zero and HS-Trail records are displayed.  When unchecked, each HS-Zero or HS-
Trail record represents one HS byte in an HS burst.  In this case, a typical HS 
burst will display many HS-Zero and HS-Trail records.  On the other hand, when 
this option is checked, only one HS-Zero and HS-Trail is displayed per HS burst, 
representing the entire HS-Zero or HS-Trail segment.  The time difference to the 
next record indicates how long the segment is.   

 Show Video Payload As Pixels (CSI & DSI) – check box that configures how 
payload data for video packets is displayed in the disassembly.  Without this 
option checked, each payload byte is displayed one-byte-per-record with no pixel 
decoding (just as all other non-video packets).  However, with this option 
checked, pixels are decoded and presented, one pixel per record, with actual color 
components values displayed.10 

 Show Pkt Fields On Payload Bytes (CSI & DSI) – check box that configures 
whether the values of packet-related fields are displayed for payload bytes in a 
packet.  For example, fields such as PktLen, VC, DataType, Frame, ActLine, etc 
are all packet fields.  Often it is useful to be able to see these fields when scrolling 
through disassembly of a long packet where the header byte has scrolled off the 
screen.  On the other hand, when searching, usually the user doesn’t want 
searches on these fields to hit on other than the first packet byte.11   

 Interpret WriteMem As Video Data (DSI) – check box that indicates that 
WriteMemoryStart and WriteMemoryContinue commands should be interpreted 
as containing video data.  WriteMemoryStart packets always start a new frame.  
The data format and line length are set by “WriteMem Pixel Fmt” and 
“WriteMem Pixels Per Line” respectively.  Note that if this option is checked and 
both WriteMemory and Packed Pixel packets are present in the trace, only 
WriteMemory frame data will be catalogued in the Video tab. 

 RAW Decode Fmt (CSI) – drop-down control that indicates the format to use for 
decoding RAW video packets.   

 

Bayer GRBG Decodes lines 1,3,5… as alternating green, red pixels and 
lines 2,4,6… as alternating blue, green pixels.   

Bayer RGGB Decodes lines 1,3,5… as alternating red, green pixels and 
lines 2,4,6… as alternating green, blue pixels.   

                                                 
10 This discussion assumes that the mnemonic view of the video packet is “Mnem and Packet Fields”.  
Otherwise, payload bytes are not visible. 
11 Note that checking the option “Search Only Pkt Hdrs” on the search tab has an equivalent effect, 
allowing only the first packet byte to qualify in searches. 
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Bayer BGGR Decodes lines 1,3,5… as alternating blue, green pixels and 
lines 2,4,6… as alternating green, red pixels.   

Bayer GBRG Decodes lines 1,3,5… as alternating green, blue pixels and 
lines 2,4,6… as alternating red, green pixels.   

Monochrome Decodes raw pixels as luminence values. 

 

 3D Display Orientation (DSI) – drop-down control that indicates the display 
orientation for viewing and saving 3D frames.   

 WriteMem Pixel Fmt (DSI) – drop-down control that indicates the pixel format 
to use when decoding WriteMemory commands as video data.  Options are: 

 

Packed RGB 565 Packed RGB 121212 
Packed RGB 666 Loose 20-bit YCbCr 422 
Loose RGB 666 Packed 16-bit YCbCr 422 
Packed RGB 888 Packed 24-bit YCbCr 422 
Packed RGB 101010 Compressed DSC 

 

 WriteMem Pixels Per Line (DSI) – text box that indicates the number of pixels 
per line when decoding WriteMemory commands as video data. 

 Use File PPS (DSI) – check box that determines what PPS is used for decoding 
compressed video frames.  If checked, the PPS Filename is used to extract a PPS 
to use for decoding.  Otherwise, PPS data from the Picture Parameter Set 
command is used. 

 PPS Filename (DSI) – text box that names a file to use for extracting a PPS 
structure to use for decoding compressed video frames (if Use File PPS is 
checked).  If the file extension is “.dsc” then the DSC file is decoded to extract the 
PPS.  Otherwise, the file is treated as a binary file and the first 128 bytes of the 
file are used as the PPS. 

4.3.4.2 Filter Tab Page 
The filter tab provides controls to filter or show records based on user criteria.  
Specifically, most controls in this tab help to define and apply a filter equation that is 
evaluated against each record to determine whether or not the record is displayed.  Note 
that the application of the filter or show result is only against the records that remain 
visible as allowed by other options.  
 
Some controls such as the Filter, Show, and Disable radio buttons update the disassembly 
listing as soon as they are used.  On the other hand, changes in the Mnemonic Type list 
box and the Filter Term grid do not take effect until the Apply button is clicked. 
 
  Here is an overview of the controls contained in the filter tab: 
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 Mnemonic Type List Box – contains a list of all mnemonic types defined for the 
current view.  The user checks packet-types and record-types to use as criteria for 
the overall filter equation.   

 Filter Term Grid – defines predicate terms of the filter equation based on packet 
fields. 

 Set All Button – checks all mnemonic types in the list box. 
 Clear All Button – clears all selected mnemonic types in the list box. 
 Filter Radio Button – enables record filtering and uses the filter equation to 

determine which records should not be displayed (i.e. if the filter equation 
evaluates true for a record, it is not displayed).   

 Show Radio Button – enables record filtering and uses the filter equation to 
determine which records should be displayed (i.e. if the filter equation evaluates 
true for a record, it is displayed).   

 Disable Radio Button – disables record filtering. 
 Clear Button – clears all terms in the filter term grid. 
 Apply Button – Applies any changes to the filter criteria, updating the 

disassembly listing. 
 
The Mnemonic Type list box and the Filter Term grid together define the overall filter 
equation.  The list box defines a set of mnemonic types that qualify records for further 
evaluation by the filter terms.  That is, records that satisfy the filter equation must have at 
least one lane with a mnemonic type than is checked in the list box.  So, for example, at 
the extremes, if no types are checked, the filter equation will evaluate false for all 
records.  And if all types are checked, the filter equation for each record will evaluate 
solely to the result from the Filter Term grid. 
 
The Filter Term grid defines zero or more Boolean terms (one per row) which compare a 
record field to a constant value.  Terms are logically connected via AND or OR 
operations to build a Sum-Of-Products equation used in the overall filter equation.  The 
AND operation takes precedence over the OR operation so A AND B OR C AND D is 
evaluated as (A AND B) OR (C AND D). 
 
The filter grid defines four columns as follows:   
 

 Op – defines how the term is logically connected to its predecessor, either via 
AND or OR (the first term, which has no predecessor is fixed to show IF).  In 
addition to showing the logical operation associated with the term, this field is a 
drop-down control that provides options for adding or deleting terms.  For AND 
terms, two options are available: add another AND term to the product or delete 
the current AND term.  For IF or OR terms, two additional options are available: 
add another OR term to the equation or delete the current OR term (which 
includes all AND terms of the product). 

 Field – drop-down control to select a record field name 
 Comp – drop-down control to select a comparison function (==, !=, <, <=, >, >=, 

has, !has) 
 Value  – editable drop-down control to select or enter a comparison value 
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The “has” and “!has” comparison function are used for substring comparison for string 
fields.  In this case, the value entered only needs to be matched (has) or not matched 
(!has) as a substring in the field to qualify.  Note that the “has” and “!has” comparisons 
are treated as “==” and “!=” if the fields are numeric.  Also note that all string 
comparisons are not case sensitive. 
 
To define a filter equation, begin with filling in the Field, Comp, and Value fields of the 
first term in the Filter Term grid.  Next, select the Op drop-down and select “<Insert OR 
term>” or “<Insert AND term>” to add a new term to the equation.  Fill in the fields of 
that term and continue inserting terms until the equation is fully defined. 
 
Another method is to right-click in the disassembly grid and select one of the menu 
options that begin with “Exclude All But…”.  Alternatively, each of these menu options 
has a keyboard shortcut sequence that begins with Ctl-X.  For example, if you right-click 
on a cell in the PktLen field that has a value of 4 and select “Exclude All But Same Val”, 
the filter list box will check all packet types and enter the term“IF PktLen == 00004” in 
the filter grid.  Then, the Show radio button will be selected and then the disassembly will 
update.   
 
Figure 6 shows the results of this operation for a video capture.  In particular, filtering has 
eliminated all packets except for VSync Start.  In addition, additional filter criteria limits 
records to those with the Frame between 4 and 15.  Note that rows have a double-line 
dividing them.  This is an optional highlighting method to indicate there are packets in 
the view that have been filtered.  This highlight is enabled by checking “Highlight Filter 
Gaps” in the Options tab.  
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Figure 6 – Filter Example 
Numeric field values are assumed to be in decimal unless appended with an ‘h’ for a 
hexadecimal value or a ‘b’ for a binary value.  When using hex or binary values, an ‘x’ 
may be used as a “don’t care” placeholder.  Thus, the value “1xh” will match values from 
10h to 1fh. 
 
Symbolic field comparison symbolic is supported, but the user should understand that 
values are compared using string-comparison and so results may not be as intended.  For 
example, if the user constrains the filter equation to select a time range when the Time 
field is set to symbolic, he might set up the following equation: 
 

IF  Time > 100 us AND Time < 200 us 
 
However, the result of the string comparisons against Time values such as “120.888 ns” 
and “190.666666666 ms” will not be as desired.  In general, the “==” and “!=” 
comparison operations are most predicatble, though be aware that comparisons are case-
sensitive.   
 
Note that changing the radix of a field from numeric to symbolic or symbolic to numeric 
after defining filter or search terms can affect the term’s validity.  Comparisons are 
performed on field values in the radix they are displayed (not the radix at the time the 
predicates were built).  An error will occur if filtering or searching using a non-numeric 
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predicate value on a field that is currently being displayed as a numeric value (though 
hex, decimal, and binary conversions are automatic).     

4.3.4.3 Search Tab Page 
The search tab contains controls for searching and optionally highlighting records that 
satisfy given criteria.  Statistics about filtered and matched search records are also 
displayed.   
 

 

Figure 7 – Search Tab 
Here is a description of the controls contained in the filter tab: 
 

 Highlight Selected – when checked, records satisfying the search criteria are 
highlighted in the listing. 

 ECC Err Cnt – displays the number of packets in the listing that have an ECC 
error.  This label is clickable to auto-fill the Search Term Grid for highlighting 
and locating ECC error packets. 

 CRC Err Cnt – displays the number of packets in the listing that have a CRC 
error.  This label is clickable to auto-fill the Search Term Grid for highlighting 
and locating CRC error packets.  In Figure 7 above, the search term for finding 
CRC errors has been auto-filled by clicking on the “CRC Err Cnt” label.  

 Burst Err Cnt – displays the number of packets in the listing that have a burst 
error.  This label is clickable to auto-fill the Search Term Grid for highlighting 
and locating burst error packets.   

 Search Cnt – displays the number of records and percentage of all acquired 
records that satisfy the search criteria.  Depending on the size of the trace, the 
current view, and the complexity of the filter and search equations, performing a 
count of all search records in the trace can be time consuming.  An initial attempt 
to update the search count is made during disassembly update, but with a ½ 
second timeout.  If the timeout occurs, the Search Cnt is displayed as “<update>”, 
indicating the user needs to click on the Update Srch Cnt button if to recomputed. 

 Visible Cnt – displays the number of records and percentage of all acquired 
records) that are currently visible in the listing. 

 Hidden Cnt – displays the number of records and percentage of all acquired 
records that are currently hidden from view in the listing. 

 Total Cnt – displays the number of acquired records. 
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 Update Srch Cnt Button – updates the Search Cnt readout if the initial attempt 
during disassembly update timed out (see Search Cnt Readout description). 

 Next Pkt Button – scrolls to the next packet in the disassembly listing.  Alternate 
ways of performing this function is to select “Next Packet” from the disassembly 
context menu or pressing Ctl-P. 

 Prev Pkt Button – scrolls to the previous packet in the disassembly listing.  
Alternate ways of performing this function is to select “Prev Packet” from the 
disassembly context menu or pressing Alt-P. 

 Next Search Button– scrolls the listing to the next record matching the search 
criteria.  Alternate ways of performing this function is to select “Next Search” 
from the disassembly context menu or pressing Ctl-S. 

 Prev Search Button – scrolls the listing to the previous record matching the 
search criteria.  Alternate ways of invoking this function is the select “Prev 
Search” from the disassembly context menu or pressing Alt-S. 

 Search Term Grid – allows the user to define predicate terms of the search 
equation.  This grid operates identically to the Filter Term grid described in the 
previous section.   

 Search Only Pkt Hdrs – when checked, restricts searches to only the first byte of 
a packet, which may improve search/update speed greatly (depending on other 
view settings).  Generally, most user search criteria are intended for packet level 
search anyway. 

 Clear Button – clears and filter term grid. 
 Apply Button – Applies changes to the search term grid, updating the 

disassembly listing and readouts. 
 
To search for and highlight records that satisfy a particular predicate equation, search 
criteria can be entered in to the search term grid identically to the filter term grid.  The 
search equation is built from terms defined and applied to each record in the listing when 
the Apply button is clicked.  If the Highlight Selected checkbox is checked, records that 
satisfy the search equation are highlighted in the listing (note that the search equation is 
only evaluated against unfiltered records).  The “Next Search” and “Prev Search” buttons 
can be used to scroll the listing to the next and previous qualifying records respectively. 

4.3.4.4 Video Tab Page 
The Video tab of the Disassembly Control panel contains information about video frames 
decoded from the trace (see Figure 8) 
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Figure 8 – Video Tab 
In the video tab, a grid control displays one-line-per-decoded-frame having the following 
fields: 
 

Frame A frame number assigned to the frame 
Sel Click-area to select the frame for saving.  An ‘X’ is 

alternately displayed and cleared with each click. 
Time Time stamp of first frame packet (generally Frame 

Start or VSync Start packet) 
VC Virtual channel 
Type Video format  
HAct Number of active pixels in a packet.  If variable 

packet lengths were found, indicates the longest 
packet found. 

VAct Number of active lines  
Complete ‘Yes’ is displayed if Frame Start and Frame End 

(CSI) or VSync Start and a second VSync Start 
(starting the next frame for DSI) was seen. 

LineTime The longest time period between active packets (CSI) 
or HSync/VSync Start packets (DSI). 

FrameTime The time between Frame Start (CSI) or VSync Start 
(DSI) and the next Frame Start or VSync Start. 

Hz The Frequency between Frame Start (CSI) or VSync 
Start (DSI) and the next Frame Start or VSync Start. 

View Click-area labeled “View” to bring up a window 
displaying the video frame. 

 

4.3.4.4.1 Scrolling Disassembly to Frame Start 
To scroll disassembly to the location of the first packet in the video frame, click on the 
frame number in the video grid.  The first packet of a video frame is usually the Frame 
Start or VSync Start packet, but if these packets are missing, they could be other video 
packet types. 
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4.3.4.4.2 Viewing Video Frames 
To view a video frame, click on the “View” cell associated with the frame in the video 
grid (see Figure 9).  This brings up the Frame Display dialog showing the captured frame, 
with a title that indicates the frame number being displayed and its dimensions. 
 
The user can resize the dialog manually using the mouse by grabbing a dialog edge and 
dragging.  If the image becomes too large for the dialog size, scroll bars appear to pan the 
image into view.  
 
The Frame Display dialog has the following controls: 
 

 Next / Prev – buttons to single-step forward or backward in the frame sequence, 
allowing each frame to be viewed in turn. 

 Play – button to play and loop the frame sequence (at a slow rendering rate not in 
real-time). 

 Frame Slider -- unlabeled slide control representing the frame sequence with the 
current slide position indicating the current frame.  Dragging the slide control 
selects the current frame.   

 Resize – button to force resizing the dialog to fit the acquired frame 
 



The Moving Pixel Company DPhyDecoderHSCtl User’s Manual. – Rev. 1.7 -- 6/12/18 

- Page 48 - 

 

Figure 9 – Frame Display Dialog 
 
In addition, the dialog has option buttons to select one of the following resize modes: 
 

 No Auto-Resize 
 Auto-Resize (Grow Only) 
 Auto-Resize 

 
These options determine when the dialog is automatically resized to fit the image.  Note 
that the image itself is not resized, just the dialog.  Selecting “No Auto-Resize” means 
that the dialog is never automatically resized to fit the image. Whereas, “Auto-Resize 
(Grow Only)” causes the dialog to auto-resize if it is too small to display the image (but 
not too large) and “Auto-Resize” allows the dialog to always adjust to the image it 
displays. 
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4.3.4.4.3 Saving Video Frames 
To save video frames to files, click on the cell labeled “View” for each frame you want to 
save, causing an ‘X’ to be displayed indicating that the frame is selected to be saved.  
Clicking on an ‘X’ unselects the frame.  Alternatively, clicking on the “Chk All” button 
selects all frames and clicking on the “Chk None” button clears all frame selections.   
 
Once frames have been selected, clicking the “Save Frames” button brings up a save 
dialog to browse and enter a file name.   
 
The extension used for the file name indicates the format to use for saving the frame data.  
If the extension is “BMP”, “JPG”, “GIF”, “.PNG”, “.TIFF” (case is irrelevant), the file is 
saved in the requested format.  Otherwise, the file is saved in binary format, exactly as 
received from the MIPI bus. 
 
In saving a single frame, the file name is used unchanged.  In saving multiple frames, the 
file name, minus extension, should end in a number.  This number will be incremented 
for each frame saved.  For example, if the save file name is “Frame123.bmp” and three 
frames are selected, they will be saved as “Frame123.bmp”, “Frame124.bmp”, and 
“Frame125.bmp”.   
 
Note that if the frame is compressed DSC video, the file format saved is determined by 
the file extension as follows: 
 

 DSC: file is saved as compressed DSC file 
 BMP, JPG, GIF, PNG, TIFF: file is saved in requested image format 
 Others:  file is saved as binary file, where only chunk data is written to file 

4.3.4.4.4 Stereoscopic Frame Processing 
DSI 1.2 supports stereoscopic frame transport, enabled and configured by fields in the 
VSync Start packet.  DPhyDecoderHSCtl provides support for viewing and saving 
stereoscopic frames as follows: 
 

 A stereoscopic frame that is pixel- or line-interleaved is first de-interleaved before 
viewing or saving to an image file.  A stereoscopic frame that is frame-interleaved 
is not deinterleaved in any way (even if 3DVSync is false). 

 A Stereoscopic frame that have a stream orientation opposite as the “3D Display 
Orientation” setting is rotated -90 degrees before viewing or saving to an image 
file. 

 A stereoscopic frame saved to a binary file is always saved exactly as received, 
without modification. 

4.3.4.4.5 Decoding Compressed DSC Video 
DPhyDecoderHSCtl now supports the DSC version 1.2 standard, including support for 
RGB and YUV color spaces as well as 4:2:2 and 4:2:0 sampling.  Decoding compressed 
DSC video requires an associated Picture Parameter Set (PPS) to convey decoding 
parameters.  The model used by DSI is that up to four PPS tables can be stored in the 
DUT to be used for decoding and two commands are used to support PPS table 
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management.  The Compression Mode command indicates the currently active PPS and 
the Picture Parameter Set command allows updating the PPS table stored in the DUT. 
 
Complicating decoding compressed video for the application is that an acquisition may 
not capture all the Compression Mode or Picture Parameter Set commands associated 
with compressed video frames in the acquisition.  In this case, the disassembler may not 
be able to correctly decode captured compressed video frames.  The following 
summarizes how the application behaves with respect to PPS management and decoding 
compressed video: 
 

1. The application emulates the DUT in maintaining and updating four PPS tables 
based on acquired and disassembled Compression Mode and Picture Parameter 
Set commands encountered in the stream. 

2. PPS tables are maintained and used for decoding even across multiple 
acquisitions and they are also saved in configuration files.  However, they are not 
saved and restored when the application is closed and relaunched. 

3. If no Picture Parameter Set has been seen for the currently selected PPS table, an 
error is displayed when the user views or saves a compressed frame. 

4. The user can override internal PPS table usage with the “Use File PPS” checkbox 
in the disassembly Options tab page.  When checked, the user provides a DSC or 
128-byte binary file to use as a PPS reference.    

4.3.4.5 Packets Tab Page 
The Packets tab page shows a summary of all packet types acquired in the trace (see 
Figure 10). 
 

 

Figure 10 – Packets Tab 
In this display the packet counts of each packet type, separated by Virtual Channel, are 
shown.  Clicking on a column header alternately sorts the display in ascending or 
descending order based on the column content.  As seen in the figure, DCS command 
categories are summarized as well as individual DCS packet types. 
 
Note that totals encompass all packets, including those that may be hidden from display 
via filter criteria.  In addition, some packets count towards more than one category 
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because some categories are summary categories.  In addition to the DCS categories, 
other summary categories include: 
 

 Escape Packets 
 Packets With CRC Error 
 Packets With ECC Error 
 Raw Packets 
 Burst Error Packets 

 
Finally, clicking in the Search column fills in the search criteria on the Search tab with 
the appropriate information and scrolls to the nearest occurrence in the disassembly.   

4.3.4.6 <Minimize> Tab 
The <Minimze> tab is used to collapse the Disassembly Control panel, so that only the 
tab labels remain.  This allows the disassembly grid can be expanded using up almost all 
the area of the disassembly window.  The Disassembly Control panel re-expands when 
any other tab is clicked. 

4.3.5 Menu Options 
This disassembly window has two menus: File and Edit.  Menu options are described 
below: 
 
File->Export Selected Lines… – brings up the Export dialog to write selected lines to 
one of several file types: PDF, PKT, CSV, and CFG.   An easy method to export the 
entire disassembly is to use “Edit->Select All” before using this menu option.   
 
Edit->Select All – selects all lines in the disassembly. 
 
Edit->Trim Disassembly To Selected Lines – truncates acquired data to the selected 
lines, where the selected range is extended if necessary to include a preceding and 
succeeding LP segment per disassembler requirements.  Acquisition data outside the 
extended range is discarded.   
 
Edit->Clear Disassembly – discards acquired data and clears disassembly.  This is 
useful for saving configuration files without data. 
 
When this menu option is selected, a message box is displayed asking the user to confirm 
the truncation operation.   

4.4 Defining Custom Commands 
Custom commands are DataTypes or DCS command codes that are not defined in the 
relevant MIPI specification.  If present in the DPhy bus traffic, custom DataTypes for 
long packets are important to identify to ensure the DPhyDecoder does not get confused 
during parsing.  This is because the default behavior when the instrument encounters an 
unknown DataType is to assume it is a short packet.  In addition, if the user wants to 
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trigger on fields particular to a custom packet type, these DataTypes and/or DCS 
command codes need to be enumerated as well.   
 
To define custom commands, a dialog is provided when “Define Custom Commands…” 
is selected from the Config menu (see Figure 11).  This dialog lets you specify custom 
short packet data types, long packet data types, custom short DCS commands, and 
custom long DCS commands.  Simply enter lists of values (separated by spaces) in the 
appropriate text boxes and click OK.  Values are parsed as decimal unless appended with 
an ‘h’, in which case they are parsed as hexadecimal (i.e. 20h = 32 decimal). 
 
Custom data type values are allowed to be 8-bits as some user’s hardware can allow use 
of the 2-bit VC field as part of the data type for test modes (outside of the protocol 
standard).  So, if a value is less than 64, it is assumed to apply for all VC settings (0-3), 
but if a value is greater than or equal to 64, it is assumed to ignore the VC field.  For 
example, adding a custom long packet data type of 22h tells hardware to treat data IDs of 
22h, 62h, a2h, and e2h as long packets.  But adding a custom long packet data type of 
42h tells hardware to treat only DataID equal to 42h as a long packet. 
 
Once custom data types and DCS commands are been defined, options for selecting these 
packets will appear in the Custom Commands tree-view node for triggering.       
 
Click the Clear All button to clear all the text boxes.     
 
 

 

Figure 11 – Custom Command Dialog 
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4.5 Exporting Disassembly 
The Export dialog can be used to export a selected range of disassembly rows (or its 
corresponding packet data) to a file (see Figure 12).  To use the dialog, select one or more 
lines in the disassembly window and select the “File->Export Selected Lines…” menu 
option.  Click on the file type and check any option you want then click OK to browse 
and select the filename.  Click Save to create the file. 
 

 

Figure 12 – Export Dialog 
 
Several file types are available, defining what is exported and its format.  The 
following formats are supported: 
 
PDF – Adobe Portable Document Format.  Selecting this format creates a PDF 
file with content from the selected rows from disassembly listing grid exactly as 
currently formatted.  Note, if too many columns are visible, rows will be split 
across multiple pages.  Thus, you first may want to use the column context menu 
by right-clicking in a column header and select “Configure Columns” to adjust 
column order and visibility in the listing. 
 
Use the check-box labeled “Landscape” to format the listing on document pages 
in either Portrait (unchecked) or Landscape (checked) mode. 
 
PKT – Moving Pixel Packet File Format.  Selecting this format creates a PKT 
file, which is a binary file containing acquired packet data spanning the selected 
rows in the disassembly.  This file format is described further below.   
 
Use the check-box labeled “Visible Packets” to determine whether all valid 
packet data in the selected disassembly range is output (unchecked) or only the 
data from visible packets in the selected range is output (checked).  This option 
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only has an effect when disassembly records are filtered using criteria from the 
Filter tab of the disassembly window.   
 
CSV – Comma Separated Value.  Selecting this format creates a CSV text file, 
which contains the ASCII text of each row in the disassembly listing exactly as 
currently formatted.  Each row in the file consists of visible field values (as 
ASCII text) each separated by commas.   
 
CFG – Moving Pixel Configuration File Format.  Selecting this format writes selected 
lines to a binary configuration file, which can then be subsequently loaded to show a 
truncated disassembly from the original acquisition.  This option is used to reduce saved 
configuration file sizes and keep only relevant portions of the acquisition.  Note that the 
selected range is extended if necessary to include a preceding and succeeding LP segment 
per disassembler requirements. 
 
Also note: the same file can be generated by editing the disassembly with “Edit-
>Trim Disassembly To Selected Lines” then selecting the “File->Save Cfg As…” 
menu option in the main window. 

4.5.1 PKT File Format 
As mentioned above, the PKT file format is a custom binary format used to export 
acquired packet data.  Only packet bytes from fully-formed escape, LPDT, and HS 
packets are included in the file.  LP states, HS signaling such as HS Zero, HS Trail, and 
HS Sync periods, and data from partial or error HS bursts (i.e. those without proper SOT) 
are not included in the PKT file. 
 
Byte Offset Data Type Field 
0 byte[] HdrTag = “#PKT” 
4 int Version  (currently = 1) 
8 int Packet Count 
12 double HS Bit Rate (Mbps) 
20 int Standard  (DSI == 0, CSI == 1) 
24 int Active Lane Count 
28 int Header Flags 

  b0: IsScrambled (HS packet payload is scrambled) 
  b1: WasScrambled (HS packet payload bytes were 
descrambled) 
  b2: WMIsVideo (Write Memory payload is video data) 

32 int PPS count (currently = 0) 
36 int RAW Decode Format 

   0: GRBG 
   1: RGGB 
   2: BGGR 
   3: GBRG 
   4: MONOCHROME 

40 int Write Memory Pixel Format 
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   0: Packed Pixel Stream 565 
   1: Packed Pixel Stream 666 
   2: Loose Pixel Stream 666 
   3: Packed Pixel Stream 888 
   4: Packed Pixel Stream 101010 
   5: Packed Pixel Stream 121212 
   6: Loose Pixel Stream, 20-bit, YCbCr422 
   7: Packed Pixel Stream, 16-bit, YCbCr422 
   8: Packed Pixel Stream, 24-bit, YCbCr422 
   9: Compressed DSC    

44 int Write Memory RGB Bit Order 
   0: legacy (same as video-mode) 
   1: DCS Annex A 

48 int Write Memory Pixels Per Line 
52 int Reserved 
56 int Reserved 
60 int Reserved 
   
64 128-byte Optional PPS[0] if PPS count > 0 
192 128-byte Optional PPS[1] if PPS count > 1 
320 128-byte Optional PPS[2] if PPS count > 2 
448 128-byte Optional PPS[3] if PPS count = 4 
   
64 + (128 * 
PPSCount) 

PKT[] Packet data array with Packet Count elements  

 

4.5.2 PKT Format 
The PKT format defines one Escape, LPDT, or HS packet in the acquisition.  It is defined 
as follows: 
 
Byte Offset Data Type Field 
0 int Packet Length (bytes) 
4 int Packet Flags 

   b0: Host Owned 
   b1: LPDT  
   b2: Escape 
   b3: Trig 
   b4: CRCOk 
   b5: ECCOk 
   b6: Start HS Burst 
   b24-b31: 0x55 marker pattern    

8 double Timestamp (seconds from start of trace) 
12 byte[] Packet data 
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4.6 Updating Firmware 
Periodically, new releases of firmware may be available for the DPhyDecoder 
HSinstrument.  Firmware is easily updated through the use of the Firmware dialog, 
accessible by selecting “Update Firmware” from the Control menu (see Figure 13).   
 
Many of the features of this dialog are for internal use only.  For users, the only options 
are to program new firmware or to verify existing firmware.  Simply browse for the 
firmware filename (extension .rbx) and click either Program or Verify respectively.  Once 
the task has begun, the relevant button changes its label to Stop, allowing the user to halt 
the task before completion.  This is fine for verification but is not generally 
recommended when programming, as this will render the instrument inoperative until 
firmware has been fully programmed.   
 
Either task takes about 5 minutes to complete, with status messages providing updates on 
progress.  When programming is complete, shut down the application and power cycle 
the instrument to reload the new firmware.  You should check that the first two LEDs on 
the instrument “twinkle” for a few seconds at power-on, indicating a successful boot.  
Otherwise, try power cycling again.  If the problem persists, you will need to reprogram 
firmware again. 
 

 

Figure 13 – Firmware Update Dialog 

4.7 Configuration Files 
DPhyDecoderHSCtl automatically saves all configuration settings (except for captured 
acquisition data) when the application closes and restores them the application is 
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launched.  The application settings file name is called App.Config and is saved at the 
following location: 
 
C:\ProgramData\Moving Pixel Company\DPhyDecoderHSCtl\App.Config 
 
The user can also save/restore configuration settings including captured acquisition data 
to a file using the “File->Save Cfg…” and “File->Load Cfg…” menu options 
respectively.  A configuration file is generally saved with the “.cfg” extension and is a 
binary file with undocumented format. 

4.8 Color Dialog 
The color options dialog allows the user to adjust colors for use in the application.  This 
dialog is experimental and only a few colors have the greatest impact on the aesthetics of 
the application, in particular, the Button background and the Form background. 
 
To bring up the Color Options Dialog, select “Set Colors…” in the Options menu.  To 
change a color, first select the color type option, for example in Figure 14, the “Form 
BG” (form background) is selected.  Then left-click and drag in the color square, adjust 
the color sliders, or type in color values to set the color.  The color rectangles to the left 
of the option buttons show the currently assigned color.  Clicking on a rectangle makes 
the selected color the current color, i.e. fills in the color settings.  This way, control colors 
can easily be copied to other controls. 
 
As colors are selected, the main window colors change to reflect the new settings.  When 
finished, click OK to keep the new colors, Cancel to discard the new colors, or Defaults 
to restore the colors to the application defaults. 
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Figure 14 – Color Dialog 
 

4.9 Menus 
This section outlines the menu commands available in DPhyDecoderHSCtl: 

 File: 
o Load Cfg… – loads a previously saved configuration file, overwriting the 

current configuration. 
o Save Cfg -- saves the current configuration and acquired data to a file.  
o Save Cfg As… -- same as the Save Cfg command above except a dialog 

is provided to browse and enter a new configuration file name. 
o <recent files> a list of the four most recent configuration files.  Selecting 

one of these file names loads the file. 
o Clear Recent File List – clears the most recent file list 
o Exit – exits the application 

 Connect: 
o Connect to DPhy Decoder HS… – brings up the Connect dialog (see 

section 4.1).  
o Disconnect From DPhy Decoder HS – disconnects from the instrument, 

putting the application in offline mode. 
o Enable RPC… -- if checked, enables user applications to communicate 

with the DPhyDecoderHSCtl software via remote procedure calls (RPC) 
to control the instrument.  The DPhyDecoderHSCtlRPC DLL provides the 
RPC interface to user programs for this purpose. 



The Moving Pixel Company DPhyDecoderHSCtl User’s Manual. – Rev. 1.7 -- 6/12/18 

- Page 59 - 

o Update Firmware... – brings up the Firmware Update dialog to 
reprogram the DPhy Decoder HS firmware (see section Error! Reference 
source not found.). 

 Config: 
o Define Custom Commands… – brings up the Custom Command dialog 

(see section 4.3) 
o Set Colors – brings up the Color Options dialog to customize the colors of 

forms, buttons, and other controls. 
 About 

o Help – displays this manual as a help file 
o Help RPC… – displays the DPhyDecoderHSCtl RPC manual as a help 

file 
o About – brings up a summary window displaying the current software 

version.  This dialog also includes a summary of release notes of 
changes/fixes for each version. 

5 Quick Start 
This section gives an overview of how to setup and configure the application to make an 
initial acquisition and disassembly. 
 

1. Run the Setup program that installs the DPhyDecoderHSCtl application and the 
USB driver used to communicate with the DPhy Decoder. 

2. Connect the DPhy Decoder instrument to your DUT.  Please refer to the DPhy 
Decoder Hardware Datasheet and User Manual for how to connect your hardware 
to the instrument.   

3. Connect the USB cable from the DPhy Decoder to the host. 
4. Power-on the DPhy Decoder. 
5. Launch DPhyDecoderHSCtl. 
6. The Connection dialog appears asking for you to select the serial number of the 

instrument for connection (see section 4.1).  If your instrument’s serial number 
does not appear in the drop-down control, check that the instrument is powered-
on and connected via USB to the host computer. 

7. Configure the main window controls as follows: 
 Set the MIPI standard to CSI or DSI as appropriate 
 Set the Max Lane Count to the number of lanes connected to your DUT 
 Set the Data Lane Map to “3210” 
 Set the Idle Timeout to, say, “1 ms”. 
 Check “Delta Mode”, “Escape Mode”, and Auto HS Freq” 
 Set the Trigger Type to “Immediately” 

8. Click the Send button to make sure all settings have been sent to the hardware. 
9. For initial testing, if possible, set up your DUT to generate continuous traffic.  It 

is best to initially start out at a relatively low frequency (100-300 MHz). 
10. At this point, you should see LP and HS activity at the bottom of the status pane 

in the main window and packet statistics begin to increment.  
11. Click on the “Show Disasm” button to bring up the Disassembly Window. 
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12. The default acquisition options are reasonable setting to use for a first acquisition.  
Thus, simply click on the “Run” button at the top, right corner of the disassembly 
window to capture your first trace data. 

 


